
 

PictureTel® LiveGateway™ Version 3.1 Online 
Installation Guide 

 

Welcome to the PictureTel family of industry standard, videoconferencing products designed specifically for 
the Local Area Network (LAN). The PictureTel LiveGateway 3.1 Installation Guide is provided in an easy-to-
use HTML format, and can be viewed with any standard Web browser.  

This online guide consists of the following HTML files. Click on a topic to obtain detailed information about it.  

• Introducing PictureTel LiveGateway (Click on this one first!) 
• Before You Begin 
• Installing LiveGateway Boards 
• Installing the LiveGateway Software 
• Managing LiveGateway from the LiveManager Gatekeeper 
• Using PictureTel LiveGateway 

Appendix A  

• Line Information for ISDN BRI Service 

Appendix B  

• I/O Port Base Address Settings 

Appendix C  

• Using the LiveGateway Event Log 
• Using LiveManager to Troubleshoot LiveGateway 
• Contacting Technical Support 

 



Introducing PictureTel LiveGateway  
 

Overview  
This guide describes how to install and configure version 3.1 of PictureTel LiveGateway on Microsoft ® 
Windows NT servers. It is intended for anyone who installs this product.  This guide assumes that you are 
familiar with installing PC add-on boards, installing and using Microsoft Windows NT applications, and 
connecting computers to peripheral equipment. It also assumes that you have Integrated Services Digital 
Network (ISDN) experience.   

The PictureTel LiveGateway 3.1 product kit contains a full-length ISA/EISA LiveGateway board, an ISDN 
cable, a bootup diagnostic diskette, and the LiveGateway software (on the CD-ROM). 

Note: If you are also using the PictureTel LiveManager gatekeeper product on your network, you must use 
version 3.1 of LiveManager. Earlier versions of LiveManager will not work with LiveGateway 3.1. 

The LiveGateway installation-related information is presented into the following sections. Click on a topic to 
obtain information about it.  

• Before You Begin 
• Installing LiveGateway Boards 
• Installing the LiveGateway Software 
• Managing LiveGateway from the LiveManager Gatekeeper 
• Using PictureTel LiveGateway 
• Line Information for ISDN BRI Service 
• I/O Port Base Address Settings 
• Using the LiveGateway Event Log 
• Troubleshooting LiveGateway from the LiveManager Gatekeeper  
• Contacting Technical Support 

To minimize network traffic, you should install LiveGateway on a network segment with a high concentration 
of LiveLAN clients. To minimize the effects of network traffic on the LiveLAN clients, you can allocate 
specific amounts of network resources to be used for LiveGateway and LiveLAN calls.  

For support or service, please contact your PictureTel sales representative or call PictureTel Technical Support. 
Refer to the PictureTel web site, www.picturetel.com, to find the appropriate Technical Support phone number 
for your geographical location. 
 



Before You Begin 
 

Overview  
Before you install LiveGateway, make sure LiveManager (version 3.1) or other H.323 Gatekeeper has been 
installed on the network and LiveLAN (version 3.0 or later) or other H.323 client, has been installed on the 
client PCs. Review the following information before you begin your LiveGateway upgrade or new installation.  

• What is LiveGateway? 
• Upgrading your version of LiveGateway 
• Contents of Server Product Kit 
• LiveGateway Documentation 
• System Requirements 
• Hardware Requirements 
• Software Requirements 
• SNMP Service 
• ISDN BRI Line 
• Board Configuration Information 
• Installation Preview 
• Related Documentation 

 

What is LiveGateway? 
LiveGateway is a bi-directional H.320/H.323-compliant gateway that provides LiveLAN and other H.323-
compliant clients access to H.320-compliant systems and other LiveLAN clients across an Integrated Services 
Digital Network (ISDN) WAN.  

LiveGateway includes a full-length ISA/EISA board and a server application installed on a Windows NT 
TCP/IP server and, if you are using PictureTel LiveManager, an optional LiveGateway Console integrated 
within and managed through LiveManager via SNMP (Simple Network Management Protocol). By using this 
LiveGateway Console, a LAN administrator can test, troubleshoot, and configure the ISDN network 
characteristics of the LiveGateway(s) installed throughout the network. 

Features of LiveGateway 

LiveGateway includes the following features:  

• H.323 to H.320 and H.320 to H.323 calling capability 
• Custom H.320 audio clip utility 
• Support for Continuous Presence 
• Single step dialing from supported endpoints 
• Option to bypass automated attendant in favor of direct connection to operator 
• DTMF Dialing or Operator Station inbound call support 
• Up to four LiveGateways (boards) may be loaded on one PC (server) 
• Translation of H.323 control to H.320 control services (call setup, call teardown) 
• Audio transcoding between H.323 audio formats and H.320 audio formats 



• H.261 video translation (packets <--> streams) 
• T.120 data sharing 
• Extensive logging capability 
• Configured and maintained at the local server console, or through LiveManager via SNMP 

LiveGateway lets LiveLAN and NetConference H.323 Multipoint Server users place and receive calls to/from 
H.320-compliant desktop and group systems such as PictureTel's Live50, Live100, Live200 desktops, SwiftSite, 
Venue and Concorde as well as other vendors' H.320-compliant systems. Through LiveGateway, LiveLAN 
users can even call an H.320 MCU (multipoint control unit) such as PictureTel's Montage and Prism and 
participate in an H.320 continuous presence multipoint conference. LiveGateway also supports T.120 data 
collaboration on supported endpoints. 

Using a single, full length ISA/EISA board, LiveGateway installs into any Windows NT 4.0 TCP/IP server or 
workstation. You can install up to four gateway boards per platform, as determined by the hardware 
configuration (CPU speed and RAM) of your server. 

With LiveGateway installed and connected to your ISDN network, LiveLAN users as well as other H.323-
compliant users can directly dial the ISDN video numbers of any H.320 user using LiveLAN's dial pad. In turn, 
H.320 users outside the LAN can call LiveLAN users using either DTMF dialing or via an operator station. 
LiveGateway also gives LiveLAN users at different sites the ability to call each other across ISDN. This is ideal 
for situations where the routed link between these sites is low-speed, or heavily congested. 

With LiveGateway, LiveLAN users and other H.323 users can participate in audio, video, and data calls with 
any H.320 videoconferencing system inside or outside their own LAN. 

LiveGateway also supports the PictureTel 330 NetConference Multipoint Server Software product. When 
NetConference is used with LiveGateway, users of NetConference can place calls to H.320 users or place calls 
to a NetConference conference room by specifying the conference room's Terminal ID. 

 

Upgrading your version of LiveGateway 
It is not necessary to deinstall previous versions of LiveGateway. All configuration information from previous 
versions will be maintained. However, if you are upgrading from an earlier release of LiveGateway (before 
version 3.0), you may need to enter a gateway prefix and a dialing prefix. 

 

Contents of Server Product Kit 
Each LiveGateway server product kit contains the following items:  

• LiveGateway Hardware Installation Guide. 
• LiveGateway CD-ROM (contains the software and online help, the online version (HTML format) of 

the installation guide, an Adobe Acrobat Reader PDF version of the installation guide, and the release 
notes).  

• LiveGateway full-length ISA/EISA board. 
• ISDN cable. 
• LiveGateway Bootup diagnostic diskette. 

If your kit doesn't have all of these items, please contact your PictureTel sales representative. 



 

LiveGateway Documentation 
The LiveGateway documentation is provided in two file formats: PDF and HTML. Use the PDF files if you 
want to view and/or print the documentation in a traditional book format. 

Note 
You need the Adobe Acrobat Reader to print/view the PDF files. This 
reader is included within the PDF subdirectory of the Docs directory on the 
CD-ROM. 

The HTML (file extension: htm) files can be viewed from within any standard web browser such as Microsoft's 
Internet Explorer or Netscape's Communicator. 

 

System Requirements 
This section identifies the minimum system requirements for running LiveGateway on a Windows NT TCP/IP 
server. The information is organized into the following categories:  

• Hardware Requirements 
• Software Requirements 
• SNMP service 
• ISDN BRI line 
• Installation location 
• Board configuration information 

 

Hardware Requirements  

Before you install LiveGateway, make sure your computer meets the following minimum hardware 
requirements:  

• 19 MB of available hard disk space  
• ISA (AT) or EISA bus, with one full-length expansion slot available  
• An ISDN BRI line  
• An NT1 network device with a power supply (or a digital Private Branch Exchange (PBX) connection)  
• One of the following processors, depending on how many LiveGateway boards you are installing: 

Note Depending on your server's hardware configuration, up to four LiveGateway boards can be installed.

Number of 
Boards Server Requirement 

1   66 MHZ 80486 processor with 16 MB of memory (16 MB of virtual memory for the swap 
file) (Minimum) 

2   90 MHZ Pentium processor with 32 MB of memory  (Minimum) 



3 or 4 200 MHZ Pentium Pro processor with 32 MB of memory (64 MB recommended)  

 

Software Requirements  

Your network environment must meet the following minimum software requirements:  

• Windows NT 4.0 TCP/IP server 
• WinSock 1.1 (or later) 
• SNMP service (optional) for managing LiveGateway from the LiveGateway SNMP Manager of the 

LiveManager gatekeeper 

 

SNMP Service  

Simple Network Management Protocol (SNMP) is a protocol that is available on Windows NT. LiveGateway’s 
use of SNMP lets you manage the LiveGateway (installed throughout your network) remotely through the 
LiveManager Console. To manage LiveGateway from the LiveManager Console, you need to enable SNMP 
service when you install LiveGateway. Refer to Installing the LiveGateway Software for the instructions for 
enabling SNMP service for LiveManager when you install LiveGateway.  

Refer to Chapter 2, Installing LiveManager of the PictureTel LiveManager Install Guide for instructions on 
how to install the LiveManager Console component of LiveManager on a Windows NT 4.0 (or later) server or a 
Windows NT or Windows 95 client.  

If you want to manage LiveGateway through the LiveManager Console, but you do not have SNMP service, 
contact your network administrator.  

 

ISDN BRI Line  

LiveGateway comes ready to connect to an ISDN Basic Rate Interface (BRI) with either National or Custom 
ISDN BRI service. You need the following ISDN service, equipment, and information to install LiveGateway:  

• ISDN BRI Access 

For information about obtaining ISDN BRI access, call PictureTel at 1-800-716-6000, and 
request the following documents: 

• ISDN Overview (number 3321) 
• Contacts for Network Service and Equipment (number 3311) 

• A Network Termination (NT1) connected to your ISDN network  

Note 
If you are connected to a Private Branch Exchange (PBX), check your PBX 
requirements. Depending on the type of PBX system you are using, you might 
not need an NT1. 



• An ISDN protocol  

Depending on the ISDN protocol you use, you might also need the following information: 

• Number Type and Number Plan 
• Channel 1 and 2 Service Provider Identifier (SPID) numbers 
• Channel 1 and 2 Multiple Subscriber Numbers (MSNs) 

You can obtain this information from your system administrator and/or your ISDN service 
provider.  

Appendix A contains switch requirements for the following switch types:  

• AT&T 5ESS 
• Northern Telecom DMS-100 
• Siemens 
• Europe 

Your network service provider asks you for this information when you order your network service. 

 

Board Configuration Information  

After you install the LiveGateway board, the setup program will prompt you for the following configuration 
information: 

Note 

Before you enter your LiveGateway board configuration information, make sure that the 
LiveGateway board's IRQ and I/O settings don't conflict with other settings currently in use on 
your server. Refer to the Finding and Resolving I/O and IRQ Conflicts section in Chapter Two 
of this Installation Guide for more information. 

• ISDN Switch Information 

Obtain this information from your ISDN service provider: 

• Switch type 
• Switch initialization type 
• Your Service Provider Identification ( SPID) for North America 
• Your Multi-Subscriber Number ( MSN) for Europe and Asia 

Note Some ISDN switches do not require SPIDs or MSNs. 

• Number plan 
• Number type 

• LAN Information 

Obtain this information from your LAN administrator: 

• Host name and IP address of the LiveManager server 



• Whether SNMP is available in your network 

• Prefix Information 

Obtain this information from either your system administrator or ISDN service provider: 

• Gateway Prefix 
• Dialing Prefix 

 

Installation Location 

Where you install LiveGateway on your network can have an impact on network performance. Before installing 
LiveGateway, carefully review your network topology and, if necessary, adjust the design of the topology to 
ensure optimal performance by minimizing network traffic.  

If possible, utilize H.323 zones to achieve optimal network performance. An H.323 zone is a logical collection 
of terminals, gateways and MCUs managed by a single gatekeeper, such as LiveManager, that is used to 
identify or group devices together for organizational purposes. 

To optimize network performance and minimize network traffic, you should install LiveGateway on a network 
segment, or zone, with a high concentration of LiveLAN clients. To minimize the effects of network traffic on 
the LiveLAN clients, you can allocate specific amounts of network resources to be used for LiveGateway and 
LiveLAN calls. 

 

Installation Preview  
The following list provides an overview of the major steps associated with installing and testing LiveGateway 
on a Windows NT server. Please review these steps before installing LiveGateway.   

1. Install the LiveGateway board. 
2. Run the diagnostics to check for I/O port conflict. 
3. Install the LiveGateway software. 
4. Enable access to SNMP (if you have it). 
5. Start LiveGateway. 
6. Managing LiveGateway from the LiveManager Console (if SNMP service is enabled). 
7. Make a call. 

 

Related Documentation  
If you are using PictureTel's LiveLAN, NetConference, or LiveManager products with LiveGateway, please 
refer to the documentation that came with those products for more detailed information about them. If you are 
using another vendor's H.323-compliant client and/or gatekeeper, refer to the vendor's documentation for more 
detailed information about these products. 



Installing LiveGateway Boards 
 

Overview  
You can install as many as four LiveGateway boards in one Windows NT server. Each board provides one 
H.323 to H.320 connection. The following information describes how to install and remove LiveGateway 
boards. The procedures for installing a LiveGateway board are summarized as follows:  

• Determine your LiveGateway I/O and IRQ settings, and resolve any conflicts. 
• Install the LiveGateway board(s). 
• Prepare the board configuration information that you will need during the software installation. 

The LiveGateway board installation and removal information is organized into the following topics. Click on 
the appropriate topic to obtain more information about it.  

• Finding and resolving I/O and IRQ Conflicts 
• Using the Windows NT Diagnostics 
• I/O Port Base Address Settings 
• Resetting DIP Switches 
• IRQ Settings 
• Installing the LiveGateway Board 
• Power On Self Test (POST) 
• Running Bootup Board Diagnostics 
• Preparing Board Configuration Information 
• Installing Additional Boards 
• Removing LiveGateway Boards 

 

Finding and Resolving I/O and IRQ Conflicts 
Before you install the LiveGateway board, make sure the default I/O settings do not conflict with other settings 
that are currently in use on your server.  

Using the Windows NT Diagnostics 

The Windows NT diagnostic program provides a utility for finding available I/O and IRQ address settings. 
Perform the following procedure to check the server’s current settings using the Windows NT diagnostics:  

1. Click the Windows NT Start button. Select Programs ->Administrative Tools -
>Windows NT Diagnostics. 

2. Click the Resources tab. 

3. Click the IRQ button. Check the list to determine which addresses are free (for 
example, 5, 7, 9, and 15). 

4. Click the I/O Port button. Check the list to determine which addresses are free (for 
example, 380) 



The following sections describe the LiveGateway default settings, and provide instructions for changing the 
settings, if necessary, to avoid conflicts.  

 

I/O Port Base Address Settings 
The default I/O port base address setting, as configured on the LiveGateway board's DIP switch for the 
LiveGateway board is 380 (hexadecimal). The following illustration shows the default DIP switch settings for 
each of the two types of LiveGateway DIP switches used with the LiveGateway board. Your LiveGateway 
board will have one of these DIP swicthes.  

 
Note: Each LiveGateway board requires 32 bytes of address space. 

If the LiveGateway default address (380) conflicts with the I/O address of another device, you need to reset the 
DIP switches to a different value before installing the LiveGateway board in the PC. A list of I/O port base 
address settings is provided in Appendix B.  

 

Resetting DIP Switches 

 

The LiveGateway board can be damaged by static discharge. To equalize static charge, ground 
yourself by touching the metal back panel of your computer. Do not use a pencil to slide DIP 
switches; the graphite can damage the switch. 

To reset the LiveGateway I/O port base address setting:  

1. Unpack the LiveGateway board by removing it from the plastic antistatic package. 
2. Compare the available I/O address settings, obtained when performing the Windows NT 

diagnostic program, with the default LiveGateway I/O address setting. If the default 
LiveGateway board I/O setting is available, install the board. If the default LiveGateway board 
setting is in use, proceed to step 3. 

3. Select one of the I/O port base address settings. 
4. Change the setting. Use a paper clip to slide the DIP switches. 

 

IRQ Settings 
The default LiveGateway ISA bus IRQ Address is 15. The IRQ address is set using the LiveGateway software, 
as described in Installing the LiveGateway Software. Be sure to run the Windows NT diagnostic utility to check 
for IRQ conflicts before setting the LiveGateway IRQ address during the LiveGateway software installation.  



 

Installing the LiveGateway Board 

 

Electrical current from power, telephone, and signal cables is potentially hazardous. When 
installing, moving, or opening your computer, disconnect all signal cables in accordance with 
national and local laws. Do not connect or disconnect LiveGateway components when your 
computer is on, as you might damage the LiveGateway hardware. To prevent electrostatic 
damage to the board, do not disconnect the power cable from the computer 

To install the LiveGateway board:  

1. Power off the server. 
2. Install the board in an available ISA or EISA full-length expansion slot, as shown below. Note: Your 

board will have only one of the two switches shown in the illustration. 

 

3. Connect the LiveGateway to the ISDN BRI by plugging the ISDN cable into the RJ45 socket on the 
LiveGateway board. 

4. Run the Bootup Board diagnostics. The Bootup Board Diagnostics program is provided on a separate 
diskette that was provided with your LiveGateway kit. 

 

Power On Self Test (POST) 
Whenever the LiveGateway Service is started or restarted, LiveGateway performs a Power On Self Test 
(POST). You can also perform the POST test from within the LiveManager gatekeeper application by using the 
LiveGateway SNMP Manager which is accessible from both the File menubar and the toolbar of LiveManager.  



To perform the POST test:  

1. Select the server you want from the LiveGateway SNMP Manager's main application window. Once you 
have made your selection, the LiveGateway Server window is displayed.  

2. Select the board you want to self test from this window. 
3. Select Self Test form the Operations menu on the LiveGateway Server menubar to run this test from 

LiveManager. When Self Test is selected, the LiveGateway board is reset and the POST test is 
performed. 

When the POST runs, the LEDs (light emitting diodes) on the LiveGateway board flash. These LEDs can be 
viewed from the side of the LiveGateway board's bracket as shown in the following illustration  
   

  

 The POST test numbers are documented in hexadecimal notation. LEDs #0 through #6 are used to indicate the 
POST test number associated with the specific diagnostic test currently running on the LiveGateway hardware. 
Each LED corresponds to a bit number in the hexadecimal test number. For example, if LEDs #0 and #6 are lit, 
then this indicates POST test number, 0x41.  

LED #7 will flash repeatedly to let you know that a POST is being performed and that the tests are executing. If 
the POST test was completed successfully, LEDs #1, #3, #5 and #7 will be lit (illuminated). If the LEDs are in 
any other pattern, then a POST failure occurred. The failure codes are documented in the LiveGateway POST 
Results.  
   

Running Bootup Board Diagnostics 
Use the Bootup Board diagnostic utility included with LiveGateway to test the board and determine if you have 
an I/O port address conflict before you install the LiveGateway software. The diagnostic utility checks for the 
default I/O address of 380. If you are not using the default, you need to enter the address that matches your DIP 
switch settings.  

To run board diagnostics:  

1. Turn the computer off. 
2. Insert the diagnostic diskette, and power on your computer. The LiveGateway 

Customer Diagnostic program runs automatically; it takes about 40 seconds to 
complete. 

3. When the diagnostics are complete, do one of the following: 

• If the "All Test Pass" message appears, remove the diagnostic diskette, restart 
your computer, and install the LiveGateway software, as described in 
Installing the LiveGateway Software.  

• If the "ISA bus communication failure" message appears, go to step 4.  



• If the "Diagnostics FAILED" message appears, contact PictureTel Customer 
support or your service provider.  

4. Enter the I/O address that corresponds to your DIP switch settings when the 
following prompt is displayed: "Enter I/O address in HEX." 

5. The diagnostics run again.  

• If the I/O address is correct, and the "ALL Test Pass" message appears, 
remove the diagnostic diskette, restart your computer, and install the 
LiveGateway software, as described in Installing the LiveGateway Software. 

• If the I/O address is correct, and the "ISA bus communication failure" 
message appears again, contact PictureTel Customer Support. 

 

Preparing Board Configuration Information  
The following table describes the information required to configure the LiveGateway board. The fields 
identified in this table are displayed on the LiveGateway Configuration Screen when you install the 
LiveGateway software. Review the following table to prepare configuration information before you install the 
software. Refer to Installing the LiveGateway Software for instructions on installing the software and 
configuring the system.  

  
Field Description Default 

Interrupt The interrupt request used for the board, 
commonly known as IRQ. 15 

I/O Address The setting of the I/O Port Address switch.  380 
Interface The ISDN BRI. BRI 

Gateway Prefix 

The number that precedes any dialing information 
when calling through a LiveGateway (it must be 
the same Gateway Prefix as that set in 
LiveManager). 

9 

Dialing Prefix 
Any number or group of numbers to be put in 
front of a dial string in order to dial out to the 
ISDN.  

None 

Switch Type The switch type used for making a connection. AT&T 5ESS Point 
to Point 

Number Plan The network service used by conferencing calls. 
Determined by your 
telephone service 
provider. 

Number Type The type of service used. 
Determined by your 
telephone service 
provider. 

SPID 1 
SPID 2 Service Provider IDs. 

Determined by your 
telephone service 
provider. 



MSN 1 
MSN2 Multi-Subscriber numbers. 

Determined by your 
telephone service 
provider. 

State Indicates if the board is active (enabled)or 
inactive (disabled). Enabled 

Operator  Off 
Gatekeeper 
(button) 

Parameters that tell LiveGateway the 
LiveManager you want to register with. None 

Autostart 
Enabled 
(checkbox) 

When enabled, LiveGateway is automatically 
started on bootup. Enabled 

SNMP Enabled 
(checkbox) 

When enabled, the server SNMP extension is 
enabled to enable access from the LiveGateway 
SNMP Manager of Livemanager. 

Enabled 

 

Installing Additional Boards  
Depending on your server's hardware configuration, you can install up to four LiveGateway boards on each 
server in your network. With four boards installed on a server, four H.323/H.320 calls per server could occur 
simultaneously. For example, if one hundred LiveLAN systems are deployed over a network with one 
LiveManager, you could install four LiveGateway boards, with each board shared by 25 different LiveLAN 
systems. 

Before installing additional LiveGateway boards, make sure your PC meets the minimum system requirements, 
and that the I/O port base address and IRQ settings of the additional boards do not conflict with other board 
settings. Each LiveGateway board must have a separate IRQ and I/O port base address setting.  

Note: Each LiveGateway board must have a separate IRQ and I/O port base address setting.  

 

Electrical current from power, telephone, and signal cables is potentially hazardous. When 
installing, moving, or opening your computer, disconnect all signal cables in accordance with 
national and local laws. Do not connect or disconnect LiveGateway components when your 
computer is on, as you might damage the LiveGateway hardware. LiveGateway boards can be 
damaged by static discharge. To prevent electrostatic damage to the board, do not disconnect the 
power cable from the computer.  

To equalize static charge, ground yourself by touching the metal back panel of your computer. 

To install additional LiveGateway boards:  

1. Determine the appropriate IRQs and I/O addresses. 
2. Stop the LiveGateway service. A message is displayed telling you the software is no longer loaded. 
3. Shutdown and power down the server. 
4. Install the additional board(s) into an available ISA or EISA full-length expansion slot. 
5. Power on the server. 
6. Run the board diagnostics to check for I/O conflicts. 
7. Add the new board configuration information using the LiveGateway Configuration utility. 



 

Removing LiveGateway Boards 

.  

Electrical current from power, telephone, and signal cables is potentially hazardous. When 
installing, moving, or opening your computer, disconnect all signal cables in accordance with 
national and local laws. Do not connect or disconnect LiveGateway components when your 
computer is on, as you might damage the LiveGateway hardware. To prevent electrostatic 
damage to the board, do not disconnect the power cable from the computer. 

To remove a LiveGateway board:  

1. Stop the LiveGateway application. 
2. Delete the LiveGateway board configuration information for each board you are removing. 
3. Shutdown and power down the server. 
4. Remove the LiveGateway board(s) from your PC. 
5. Start the LiveGateway application. If you have not removed all of the LiveGateway boards from the 

server, you can start the LiveGateway application. 



Installing the LiveGateway Software   
 

Overview 
To install the LiveGateway software, use the Setup program described in this section. The LiveGateway Setup 
program lets you:  

• Install the LiveGateway software 
• Configure the LiveGateway board(s) 
• Edit Configuration Information 

This section contains the following information:  

• Before You Begin 
• Upgrading from a Previous Version of LiveGateway 
• Installing the LiveGateway Software 
• Configuring the LiveGateway Boards 
• Entering LiveGateway Configuration Information 
• Running the LiveGateway Configuration Utility 
• Starting the LiveGateway Application 
• Stopping the LiveGateway Application 
• Accessing the LiveGateway Audio Clip Recorder 
• Deinstalling LiveGateway 

 

Before You Begin  
Perform the following tasks before installing the LiveGateway software:  

• Identify available IRQ and I/O address settings and reset the board DIP switches if necessary. 
• Install the LiveGateway board(s).  
• Prepare the LiveGateway configuration information.  
• Make sure LiveManager version 3.1 (or other H.323 gatekeeper) has been installed on your network.  
• Obtain the LiveManager's IP address or name. 

 

Upgrading from a Previous Version of LiveGateway 
It is not necessary to deinstall a previous version before you install the LiveGateway software. All configuration 
information from a previous version will be maintained. When installing over a previous version of 
LiveGateway, the existing install directory is preserved. However, you may need to enter a Gateway Prefix and 
a Dialing Prefix (new to LiveGateway versions 3.0 and later).  

Note: Stop the previous LiveGateway Service before installing a new version. 

 



Installing the LiveGateway Software  
To install the LiveGateway software:  

1. Insert the LiveGateway CD-ROM into the CD drive. 
2. Click the Windows NT Start button on your desktop, and choose Run... The Run dialog box is 

displayed.  
3. Type d:\disk1\setup, and click OK (for CD), where d: represents the drive letter associated 

with your CD. The LiveGateway Welcome screen is displayed. 

 

  
4. Click Next > to proceed with the installation, or click Cancel to stop the installation. If you 

proceed, the Choose Destination Path screen is displayed. 



 

  
5. To choose the default location (C:\..\PictureTel\LiveGateway\) and begin the installation, click 

Next >. To enter a new path, click Browse..., enter the desired location, and click OK. 

The installation begins. The LiveGateway Setup program copies the files to the specified 
location, and a progress indicator displays the status of the installation. 

Note: If installing LiveGateway over an existing version, the location of the installed version 
will be displayed as the Destination Directory. 

When the Setup program is complete, the LiveGateway Configuration screen is displayed, as 
shown below. 



 

Configuring LiveGateway Boards 
When you configure the LiveGateway board, you need information about the ISDN BRI network interface your 
computer uses and the board settings. The configuration fields and defaults are outlined in Preparing Board 
Configuration Information.  

Accessing the LiveGateway Configuration Screen 

The LiveGateway Configuration screen is displayed automatically when the Setup program is complete. You 
can configure the LiveGateway boards as soon as the screen is displayed, immediately after installing the 
software, or you can do it later. To access the LiveGateway Configuration program later:  

Click the Windows NT Start button, and choose Programs -> PictureTel LiveGateway -> 
LiveGateway Configuration. 

 
Entering LiveGateway Configuration Information 

You can add LiveGateway configuration information immediately after loading the LiveGateway software, or 
you can add information later by running the LiveGateway Configuration Utility.  

To add configuration information now, click the Add button. List boxes appear displaying default values. A 
brief description of each list box  field on the LiveGateway Configuration screen is provided in the following 
paragraphs.  



Interrupt 

In the Interrupt field, click the down arrow to display an expanded list of IRQ values.  

 

The value you choose here cannot be used by any other device, including another LiveGateway board. For more 
information, refer to Finding and Resolving I/O and IRQ Conflicts.  

I/O Address 

In the I/O address field, click the down arrow to display an expanded list of I/O address values.  

 

Choose the same I/O address value here that you set on the I/O address DIP switches on the LiveGateway 
board. No two devices can have the same I/O address. The I/O address uses 32K of space. For more 
information, refer to Finding and Resolving I/O and IRQ Conflicts.  



Interface (ISDN BRI Configuration) 

Obtain the BRI configuration information from the Telecom Administrator who supplied the BRI line. To 
configure the ISDN BRI line, click the Configure button. The BRI Configuration screen is displayed.  

 

Gateway Prefix 

The Gateway prefix is the number that LiveLAN users must enter before an H.320 system’s dial string/phone 
number. (For more information, refer to the PictureTel LiveLAN Product Guide.) A Gateway prefix must be 
entered. The default Gateway prefix is 9.  

Note: The Gateway prefix that is set in LiveManager for this LiveGateway board must be the same as 
the Gateway prefix entered here. If it is not entered or not the same in both places, the LiveGateway 
cannot be accessed. All boards must also have the same prefix. 

LiveManager will not allow a terminal to register if the Gateway prefix (such as 9) is the first digit in its 
terminal ID.  

For more information, refer to the PictureTel LiveManager Product Guide.  

 
Dialing Prefix 

Note: The dialing prefix is an advanced administrative option and is not a requirement. 

The dialing prefix is a number or set of numbers that can be programed in by the system administrator to make 
it easier for users to dial out to the WAN.  

When a LiveLAN user dials out to the WAN, LiveManager directs the call to the closest available LiveGateway 
board on the LAN. One LiveGateway board may be serviced by an ISDN provider that requires a dialing prefix 
of 9, while another may require a dialing prefix of 7. Because LiveManager does not distinguish one ISDN 
provider from another, a dialing prefix must be used when more than one LiveGateway board is being used on 
the same LAN, but are located on different servers.  

By having the system administrator configure a dialing prefix, users can dial the Gateway prefix without 
worrying about how many LiveGateway boards they have and having to know which ISDN provider services 
each board.  

  



Switch Types 

In the Switch Type field, click the down arrow to display an expanded list of switch types.  

 
   

If you choose a switch type that requires additional information, the BRI Configuration screen expands:  

 

Check the following table for your switch type and its default values.  

Switch Type Number 
Plan 

Number 
Type SPIDs MSNs 

AT&T 5ESS Point-to-
Point  Unused  Unused  NA  NA  

AT&T 5ESS Multipoint  Unused  Unused  Required  NA  

National ISDN1  Unused  Unused  Required  NA  

DMS 100  Unused  Unused  Required  NA  

VN3  Unknown  Unknown  NA  Optional  

NTT  Unknown  Unknown  NA  Optional  



NET3 Taiwan  Unknown  Unknown  NA  Optional  

NET3 Swiss  ISDN  Unknown  NA  Optional  

NET3 Italy ISDN Unknown NA Optional 

NET3 Norway  ISDN  Unknown  NA  Optional  

NET3 Singapore  ISDN  Unknown  NA  Optional  

Euro-ISDN  ISDN  Unknown  NA  Optional  

NET1  ISDN  Unknown  NA  Optional  

1TR6  ISDN  Unknown  NA  Optional  

TPH 1962  ISDN  Unknown  NA  NA  

   

Number Plan 

ISDN is used in many different types of dedicated public switched networks. The Number Plan specifies which 
switched network to associate with the phone numbers dialed. Check the Number Plan column in the preceding 
table for the correct setting for your switch type.  

1. Click the down arrow on the Number Plan list.  
2. Click a number plan to select it. 

  

Number Type 

The number type further specifies the types of numbers dialed. Most switches accept Unknown. Check the 
Number Type column in the preceding table for the correct setting for your switch type.  

1. Click the down arrow on the Number Type list.  
2. Click a number type to select it. 

  



SPID 

Enter the alpha-numeric Service Provider ID (SPID) issued by the service provider. Because LiveGateway uses 
two BRI lines, you need to enter two SPIDs for switch types that use them.  

  

MSN 

Enter the Multi-Subscriber Number (MSN) issued by the service provider. LiveGateway uses one ISDN-BRI 
line, which has two B Channels. Because LiveGateway uses the two B Channels of this line, you need to enter 
two MSNs (if required by your service provider).  

  

State 

To specify whether the board is active or inactive:  

1. In the State field, click the down arrow button. The default value, Enabled, is highlighted. 
2. Highlight Enabled or Disabled as appropriate. 

  

Gatekeeper 

Click the Gatekeeper button to register LiveGateway with a gatekeeper such as LiveManager. To register with 
LiveManager, LiveGateway needs to know the LiveManager's Server name or IP address. To specify these 
TCP/IP parameters to LiveGateway:  

1. Click the Gatekeeper button on the LiveGateway Configuration screen. The TCP/IP Information 
window is displayed. 

 

2. Enter the LiveManager server name or IP address, and click OK. 

  

Always Use Operator 

Select this checkbox to direct all incoming LiveGateway calls to the LiveLAN client, or other H.323 client that 
supports call transfer, designated as the operator station in LiveManager's operator station mapping file. When 



this checkbox is enabled (checkmark present in box) LiveGateway will direct all incoming calls to this client for 
operator assistance. 

  

Enabling AutoStart 

Select this checkbox to automatically start the LiveGateway service on bootup. If this checkbox is not selected, 
you must start the LiveGateway service manually from the Windows NT Control Panel Services window upon 
server bootup.  

  

Enabling SNMP 

Select this checkbox to enable the LiveGateway server’s SNMP extension. SNMP is used to remotely control 
the LiveGateway service from the LiveManager console.  

Note: SNMP Service under Windows NT is not always installed, although it is available on your 
Windows NT Installation CD. Please refer to your Windows NT documentation for further information 
on installing the SNMP Service.  

Note: Enabling SNMP is recommended. To access a LiveGateway from LiveManager, SNMP must be 
enabled and the LiveGateway Service must be started. Otherwise, a system dialog box with the 
following message appears, “Cannot connect. Okay to add?”  

 

Exiting Setup 
When you have finished entering all of the necessary configuration information, click OK, and the following 
screen is displayed.  

 

You can restart LiveGateway now or later. If you click Cancel, the program returns to the LiveGateway 
Configuration utility.  

If you click Restart Later, the following screen is displayed, which indicates that LiveGateway has been 
successfully configured. Your configuration choices will not go into effect until you restart your system.  
   



 

If you click Restart Now, the following screen is displayed.  
   

 

When you click OK, LiveGateway restarts, a self-test is executed, and the following screen is displayed.  

 

Click Finish to complete the Setup program.  

After restarting, PictureTel recommends that you check the LiveGateway log file to make sure there are no IRQ 
or I/O conflicts that are unknown to the Windows NT operating system.  

 



Running the Configuration Utility 
You can change information for a LiveGateway board by running the LiveGateway Configuration utility as 
follows:  

1. Click the Windows NT Start button, and choose Programs -> PictureTel LiveGateway -> LiveGateway 
Configuration.  

2. Choose the field you want to change.  
3. Enter the new information.  
4. Click OK. A message is displayed prompting you to restart the LiveGateway service. Changes do not 

take effect until you restart the service. 
5. Choose Restart Now. 

 

Starting the LiveGateway Application 
To start LiveGateway:  

1. Click the Windows NT Start button, and choose Settings -> Control Panel.  
2. Select the Services group.  
3. Select the LiveGateway Service.  
4. Click the Start button. (Note: The Start button is available only if LiveGateway is not currently running.) 

 

Stopping the LiveGateway Application 
To stop LiveGateway:  

1. Click the Windows NT Start button, and choose Settings -> Control Panel.  
2. Select the Services group.  
3. Select the LiveGateway Service.  
4. Select the Stop button. (Note: The Start button is available only if LiveGateway is not currently 

running.) 

 

Accessing the LiveGateway Audio Clip Recorder 
The LiveGateway Audio Clip Recorder, a stand-alone utility that allows you to record customized versions of 
the LiveGateway automated attendant audio messages, is automatically installed when LiveGateway is setup on 
your server. Refer to Using PictureTel LiveGateway for information on how to access and use the LiveGateway 
Audio Clip Recorder. 

 



Deinstalling LiveGateway 
To remove LiveGateway from the server:  

1. Click the Windows NT Start button, and choose Settings -> Control Panel.  
2. Select the Services group.  
3. If LiveGateway SNMP management has been enabled, stop the SNMP service. Since you cannot 

remove a running file, you need to stop the SNMP service to deactivate the LiveGateway SNMP Agent 
Extension before you remove the LiveGateway. 

4. Start the LiveGateway Configuration utility, and click Remove in all columns to remove all boards.  
5. Exit the Configuration utility. A message is displayed to inform you that LiveGateway service has been 

removed from the registry. 
6. In the Add/Remove programs section of the Control Panel, select LiveGateway, and remove it. All of 

the installed components are removed, so the program group is gone. 
7. Click the Windows NT Start button, and select the Windows NT Explorer, and delete the 

"LiveGateway" directory. This deletes the event logs and the confighelp.gid file. 
8. Restart SNMP service in the Services section of the Windows NT Control Panel. 

  



Managing LiveGateway from the LiveManager 
Gatekeeper  

 

Overview 
This chapter describes how to view and manage LiveGateways remotely by using the LiveGateway SNMP 
Manager feature from within the LiveManager application. To use this feature, SNMP service for each 
LiveGateway must be enabled. Normally, SNMP service for a LiveGateway is enabled from the LiveGateway 
Configuration window when that LiveGateway is installed on your system. 

When SNMP service is enabled, you can:  

• Monitor the status of LiveGateway and determine its current activities. 
• Configure the ISDN BRI when you need to change WAN switch information. 
• Locate and resolve LiveGateway problems.  

Note This section assumes you have access to the LiveManager gatekeeper. For more information on 
LiveManager, refer to the PictureTel LiveManager Product Guide. 

The information in this section is organized into the following categories:  

• SNMP Service 
• Using the LiveGateway SNMP Manager 
• Saving the Window Layout & Position 
• Configuring the LiveGateway SNMP Manager 
• Adding LiveGateway Servers 
• Changing Server Information 
• Deleting Servers 
• Opening a LiveGateway Server 
• The LiveGateway Server Window 
• Working with the LiveGateway Server Window 
• Monitoring LiveGateway Status 
• Configuring the ISDN BRI 
• Setting On Line Status 
• Setting Off Line Status 
• Performing a Self Test 
• Testing and Resetting the Board 
• Performing a Loop Back Test 
• Viewing a POST Result 
• Viewing LiveGateway Board Statistics 
• Viewing Board Settings & Version Information 

 



SNMP Service 
To manage a LiveGateway server from the LiveGateway SNMP Manager, the SNMP (Simple Network 
Management Protocol) service of the LiveGateway must be enabled. 

If you checked the SNMP enabled check box on the LiveGateway Configuration screen when you installed 
LiveGateway, SNMP service is available. Refer to Chapter 4, Managing LiveGateway through the 
LiveManager Console, in the PictureTel LiveGateway Installation Guide for more information. 

 

Using the LiveGateway SNMP Manager 
You will use the LiveGateway SNMP Manager to perform the following tasks:  

• Configure the default polling and data refresh intervals used by the SNMP Manager 
• Configure the default SNMP parameters used for accessing the LiveGateway servers 
• Add new LiveGateway servers 
• Change LiveGateway server information 
• Delete LiveGateway servers 
• Open the LiveGateway server you want to work with.  

The LiveGateway SNMP Manager Window 

The LiveGateway SNMP Manager window is shown in the following illustration. 

 

The menu bar for this window lists the following selections: 

Menu Bar 
Selection Description 

File 

1. Choose "Configure..." to configure the polling intervals and data refresh intervals, and 
set the default SNMP parameters for your LiveGateway servers. 

2. Choose "Save Window Layout & Position" to save the window size, position and 
column width.  



3. Choose "Exit" to quit the application. 

View 

1. The Status Bar feature is enabled (with a checkbox) as the system default value. When 
enabled, a helpful message about the selected menu bar option is displayed at the 
bottom of the LiveGateway SNMP Manager window. To disable the status bar display, 
select and click the Status Bar option from the View menu. When the checkmark is not 
displayed, the Status Bar feature is disabled. 

2. Choose "Refresh" to read and refresh the displayed status of the LiveGateway servers.  

Operations 

1. Choose "Open Server..." to display information from the server, and allow operations to 
be performed on the server. 

2. Choose "Add Server..." to add a new LiveGateway Server to the list of servers. 
3. Choose "Modify Server..." to modify the name, address or SNMP parameters of the 

selected server. 
4. Choose "Remove Server..." to remove one or more of the selected servers from the list. 

Help 

1. Choose "Help Topics..." to display a list of help topics for the LiveGateway SNMP 
Manager. 

2. Choose "Using Help..." to display instructions about how to use the Microsoft Help 
system. 

3. Choose "About GwSnmpMgr..." to display program information, version number and 
copyright information. 

The main portion of the window lists the LiveGateway servers currently accessible from the LiveGateway 
SNMP Manager. The server information displayed in this window provides the following information for each 
server:  

• Name 
• Address 
• Status 
• Boards 

The first time you access the LiveGateway SNMP Manager, the list in this window will be empty and you will 
have to add servers as described in Adding LiveGateway Servers. 

 

Saving the Window Layout & Position 
The LiveGateway SNMP Manager window can be resized and moved on the desktop like other Windows-based 
applications. You can also adjust the width of the Name/Address/Status/Boards columns displayed in the 
window.  

To resize the LiveGateway SNMP Manager window, drag a side or corner of the window to resize it. 

To adjust the width of the Name/Address/Status/Boards columns, move the mouse between the border of 
adjacent column heading cells until the pointer changes to a double-arrow. When the cursor is a double-arrow, 
drag the cursor to change the width of the selected column. 



If you want to save all of your changes to the window size, position and column widths, choose File > Save 
Windows Layout & Position from the LiveGateway SNMP Manager window's menu bar.  

 

Configuring the LiveGateway SNMP Manager 
You can configure the polling intervals, the data refresh rate, and the default SNMP parameters used by the 
LiveGateway SNMP Manager by performing the following procedure:  

1. Select File -> Configure... from the LiveGateway SNMP Manager menu bar. The LiveGateway SNMP 
Manager Configuration window appears. The Intervals tab is displayed as the active (selected) tab. 

 

  

2. The settings for the intervals are used by the SNMP Manager until you change them. 
These settings include the following:  

a) Server Polling: Enabled 

b) Server Polling Interval: 30 seconds 

c) Data Refresh Interval: 10 seconds. 

To change the data for these settings, enter your new values in the appropriate fields. To 
disable the Enable Server Polling function, click your mouse in the Enable Server Polling 
checkbox to remove the check mark. 

3. To view or change the default SNMP parameters, click the SNMP tab to make it the 
active tab. 



 
4. To change the default values for the SNMP parameters that will be assigned to all 

LiveGateway servers added in the future, enter the values to be changed. You can assign 
the following parameters:  

a) Read Community Name 

b) Write Community Name 

c) Timeout Interval 

d) Number of times to retry. 

If you want to assign these values to all currently defined LiveGateway servers, then 
click your mouse in the "Assign these values to all currently defined servers" checkbox. 

5. Click the OK button after you have made your changes. 
 

Adding LiveGateway Servers 

To add LiveGateway servers to the list shown in the LiveGateway SNMP Manager window:  

1. Choose Operations > Add Server... .  

The Add LiveGateway Server dialog box appears, prompting you for the name or address 
of the LiveGateway server. 



 
2. Enter the name or address of the LiveGateway server in the text box of the Name/Address 

tab.  

If you are entering an address, use standard decimal notation format. An example of an IP 
server address is 140.242.70.5. 

3. Modify the SNMP parameters on the SNMP tab. 

The SNMP tab shown here allows you to specify the SNMP parameters that will be used 
for accessing the server that is being added. 

Initially this tab displays the default SNMP parameters. If it is desirable to change the 
default SNMP parameters initially assigned to a server, refer to the "Configuring the 
LiveGateway SNMP Manager" section of this document. 

 
4. Click the OK button after you have entered your address/name information and the SNMP 

parameters. 

If the information that you entered is valid, the Add LiveGateway Server closes and the 
LiveGateway SNMP Manager window is updated showing the following information for 
the LiveGateway server you entered: 

• Name 
• Address 
• Status 



• Boards 

To add more servers, repeat steps 1 through 4. 
 

Changing Server Information 

To change a LiveGateway server's name, address or SNMP parameters, perform the following procedure: 

1. Select the server from the list of servers displayed in the LiveGateway SNMP Manager 
window. 

2. Choose Operations > Modify Server... from the menu bar.  
3. The Modify LiveGateway Server dialog box appears. 

 

The Name/Address tab is displayed as the active tab. To access the SNMP tab, click on it to 
select it. 

4. Modify the Name/Address and/or SNMP parameters for the selected LiveGateway server 
5. Click the OK button on the tab after making your changes. 

If you entered a valid server name or address, the Modify LiveGateway Server window 
closes and the LiveGateway SNMP Manager window is updated showing the updated 
Name or Address information for the LiveGateway server you modified. 

 

Deleting Servers 
To delete a server from the list of LiveGateway Servers displayed in the LiveGateway SNMP Manager window: 

1. Select the server from the list of servers displayed in the LiveGateway SNMP Manager 
window. 

2. Choose Operations > Remove Server... from the menu bar. A message box appears 
asking if you want to delete the selected server. 

3. Click Yes. The LiveGateway SNMP Manager window is re-displayed. The list of servers 
is updated to show that the server has been removed. 



Multiple servers can also be deleted by selecting all of the servers to be deleted before selecting the "Remove 
Server..." menu item. The message box asking you to confirm the deletion will then appear for each selected 
server. 

 

Opening a LiveGateway Server 
The list displayed in the SNMP Manager main window identifies the LiveGateway servers and the number of 
boards installed on each server. 

If this is the first time you are accessing the LiveGateway SNMP Manager, the list is empty, and you will need 
to add servers in order to work with them.  

Perform one of the following actions to open a server.  

• After clicking on a server in the list to highlight the server, select Operations > Open Server... from the 
LiveGateway SNMP Manager's menu bar. 

• Double-click the server's entry line in the list box area of the LiveGateway SNMP Manager window. 
• Right-click your mouse when it is positioned over the server's entry line and select "Open Server..." 

from the popup menu. 
• Click your mouse in the server's status box, located to the left of the server's name. Note: clicking in this 

status box after the server is opened will close the server. 

When you have selected a LiveGateway server, a checkmark appears in the server's status box and the 
LiveGateway Server window for the selected server is displayed. If a red "X" is present in the check box for a 
server and a status of "No Response" is displayed for the server, then one of the following conditions exist:  

• The LiveGateway server is not running 
• The server's SNMP Agent is not running 
• The SNMP timeout interval is too short 
• An SNMP community name is incorrect 
• The server's IP Address is inaccessible. 

Note: If you open more than one LiveGateway server, a separate LiveGateway Server window will be displayed 
for each server. They will be displayed as a series of cascading windows. 

 

The LiveGateway Server Window 
To configure, monitor, and test the installed LiveGateway boards in a server, you must open the server. When 
you open a server, the LiveGateway Server window appears. This window displays information from the server 
and permits operations to be performed upon the server. For instructions on how to open a server, see the 
section "Opening LiveGateway Servers" in this document. 

After a server is opened, a LiveGateway Server window, similar to the one shown below, is created. The server 
name (or address if the server has no name) is shown in the title bar of the window. The following window is 
displayed for a server named "oberon." 



 

From the LiveGateway Server window, you can:  

• View the Status, Interface, I/O Address, IRQ (Interrupt), and Hardware version information for each 
LiveGateway board installed in the server 

• View the Gatekeeper's name or address 
• Configure the LiveGateway board(s) 
• Set the status (on-line or off-line) for each LiveGateway board 
• Perform a self test on a LiveGateway board 
• Perform a Loop Back test 
• Reset a LiveGateway board 
• View the POST results of a board 
• View the statistics of a board 

 

Working with the LiveGateway Server Window 
The information in the LiveGateway Server window is displayed in two tabs: the Gateway Boards tab and the 
Settings tab. 

Gateway Boards Tab 

The Gateway Boards tab, which is shown in the following illustration, displays the following information for 
each LiveGateway board in the server:  

• Board Number 
• Status 
• Interface 
• I/O Address 
• IRQ (Interrupt Setting) 
• Hardware Version 



 

  

Settings Tab 

The Settings tab, which is shown in the following illustration, provides the following information,:  

• LiveGateway Software Version Number 
• Gatekeeper Name or Address 

 

  



Using the Menu bar 

The menu bar for the LiveGateway Server window lists the following selections: 

Menu Bar 
Selection Description 

File 

1. Choose "Save Window Layout" to save the window size, current tab 
selection, and column widths.  

2. Choose "Close" to close the LiveGateway Server window. 

Note: File menu bar options are the same for both tabs. 

View 

1. Choose "Refresh" to read and refresh the data displayed in the window and 
any other windows that were opened from this window.  

Note: View menu bar options are the same for both tabs. 

Operations 

For the Gateway Boards tab: 

1. Choose "On Line." to place the LiveGateway board on line. 
2. Choose "Off Line..." to place the LiveGateway board off line. 
3. Choose "Self Test" to perform a Power On Self Test of the LiveGateway 

board. 
4. Choose "Configure..." to reconfigure your ISDN BRI. Normally the ISDN 

BRI is configured once when LiveGateway is installed. However, if your 
ISDN switch is changed, you can reconfigure the ISDN BRI from the 
LiveGateway Server window. 

5. Choose "Loop Back..." to perform a Loop Back test on the LiveGateway 
board. 

6. Choose Show POST Result..." to show the POST (Power On Self Test) 
result for the LiveGateway board. 

7. Choose "Show Statistics..." to display statistics for the LiveGateway board. 

Selections that appear "dimmed (grey)" aren't available. For example, if the 
LiveGateway board is currently "on line", the "On Line" selection will appear 
dimmed since it is already selected. 

For the Settings tab: 

1. Choose "Save Changes" to save any changes that you made to the 
Gatekeeper name or address. 

Help 

For the Gateway Boards tab: 

1. Choose "Help" to display the online help for the Gateway Boards tab. 

For the Settings tab: 



1. Choose "Help" to display the online help for the Settings tab. 

 

Monitoring LiveGateway Status 
The status information for the LiveGateway Board is displayed under the "Status" column heading on the 
Gateway Boards tab of the LiveGateway Server window.  

The following status categories may be displayed under the Status heading:  

• On Line 
• Off Line 
• Self Test 
• Download 
• Fail 
• In Call 
• Loopback 
• Disabled 

On Line 

The On Line status is displayed when LiveGateway is registered, active, and ready to receive and place (send) 
calls. A LiveGateway that displays the On Line status is registered to LiveManager.  

Note: If LiveManager is not active, the LiveGateway cannot register to it. A LiveGateway that is active but 
unregistered, displays its status as Off Line. 

Off Line 

When the Off Line status is displayed, clients cannot place or receive calls through the LiveGateway.  

Self Test 

The Self Test status is displayed for a LiveGateway that is running the start-up diagnostics. This status is 
displayed when a Power-On Self Test (POST) is performed by resetting the LiveGateway board. If the test is 
successful, the status message changes to Download. If the test fails, a Fail status is displayed. For additional 
information, refer to Appendix C.  

Download 

The Download status is displayed while files are being downloaded from the server to the LiveGateway board. 
This happens when you reset or power-up the board and a POST test completes successfully. After the files are 
successfully downloaded, the LiveGateway status changes to On Line or Off Line. Downloading a 
LiveGateway can take two to three minutes.  



Fail 

The Fail status indicates that the LiveGateway is not working because LiveGateway failed the POST test. To 
correct the problem, refer to the POST Results described in Appendix C. The Failed status remains until you 
perform another POST test, during which the Self Test status appears.  

In Call 

The In Call status indicates that the LiveGateway is busy and cannot send or receive more calls.  

Loopback 

The Loopback status is displayed when the LiveGateway is performing a loopback test. 

Disabled 

The Disabled status is displayed when the LiveGateway is deliberately brought out of service. To bring it back 
into service, use the LiveGateway Configuration application at the server console.  

 

Configuring the ISDN BRI 
You initially configure the ISDN BRI when you install the LiveGateway software. However, you may need to 
reconfigure it if your WAN switch changes.  

To configure the ISDN BRI: 

1. Open the LiveGateway server from the LiveGateway SNMP Manager main window. 

2. Select the Gateway Boards tab of the LiveGateway Server window. 

3. Perform one of the following actions: 

• Click on a board in the list to highlight the board, and select Operations-> 
Configure... from the LiveGateway Server window's menu bar.  

• Double-click the board's entry line in the list box area of the LiveGateway Server 
window. 

• Right-click your mouse when it is positioned over the board's entry line and 
select "Configure..." from the popup menu. 

4. The Configuration Gateway Board dialog box is displayed. Enter the appropriate 
information in the Configuration dialog box.  



 
5. Specify the Gateway Prefix that LiveLAN users and LiveManager will use to direct a 

call through a LiveGateway. This number is the same for all LiveGateways on the 
network. 

6. Specify the Dialing Prefix which the LiveGateway will use to make an outgoing call. 
This prefix is usually defined by the telephone switch/PBX. 

7. If you want every incoming H.320 call to be automatically routed to the operator, check 
the "Always Use Operator" check box. 

8. Choose the appropriate item for the Switch Type, Number Plan, and Number Type 
fields. Depending on what you specified for the Switch Type, you may need to enter 
additional information (Service Provider IDs (SPIDs), Multi-Subscriber numbers 
(MSNs), and ISDN Subaddresses. 

Note: You obtain BRI configuration information from your telephone company or your site's 
telecommunications manager. 

 

Setting On Line Status 
To set the LiveGateway Board's status to On Line: 

1. Open the LiveGateway server from the LiveGateway SNMP Manager window. 

2. Select the Gateway Boards tab of the LiveGateway Server window. 

3. Perform one of the following actions: 

• Click on a board in the list to highlight the board, and select Operations-> On 
Line... from the LiveGateway Server window's menu bar.  

• Right-click your mouse when it is positioned over the board's entry line and 
select "On Line" from the popup menu 

 



Setting Off Line Status 
To set the LiveGateway Board's status to Off Line: 

1. Open the LiveGateway server from the LiveGateway SNMP Manager window. 

2. Select the Gateway Boards tab of the LiveGateway Server window. 

3. Perform one of the following actions: 

• Click on a board in the list to highlight the board, and select Operations-> Off 
Line... from the LiveGateway Server window's menu bar.  

• Right-click your mouse when it is positioned over the board's entry line and 
select "Off Line" from the popup menu 

 

Performing a Self Test 
To perform a Power On self-test for a LiveGateway Board: 

1. Open the LiveGateway server from the LiveGateway SNMP Manager window. 

2. Select the Gateway Boards tab of the LiveGateway Server window. 

3. Perform one of the following actions: 

• Click on a board in the list to highlight the board, and select Operations-> Self 
Test from the LiveGateway Server window's menu bar.  

• Right-click your mouse when it is positioned over the board's entry line and 
select "Self Test" from the popup menu. 

4. After the test completes successfully, the status of the LiveGateway board changes to 
Download and then to On Line or Off Line under the Status column heading of the 
LiveGateway Boards tab.  
 
If the test is not successful, the status displayed is "Failed." To view the Power On Self 
Test (POST) result, refer to "Viewing the POST Result" section of this document. POST 
result information is useful when you test LiveGateway and you need to report problems 
to your PictureTel service provider 

 

Testing and Resetting the Board 
If the status displayed for a LiveGateway Board is "Failed", perform a Power-On Self Test (POST) by resetting 
the board. The status of a board is displayed under the Status column of the LiveGateway Boards tab of the 
LiveGateway Server window. 



To start the self-test, refer to the preceding section, "Performing a Self Test." 

 

Performing a Loop Back Test 
The Loop Back Test simulates an inbound H.320 call to a LiveLAN client. This test loops back video and audio 
at the H.320 subsystem within the LiveGateway board. All LiveLAN to H.320 transcoding paths are exercised. 

To perform a Loopback Test on a LiveGateway Board: 

1. Open the LiveGateway server from the LiveGateway SNMP Manager window. 

2. Select the Gateway Boards tab of the LiveGateway Server window. 

3. Perform one of the following actions: 

• Click on a board in the list to highlight the board, and select Operations-> Loop 
Back from the LiveGateway Server window's menu bar.  

• Right-click your mouse when it is positioned over the board's entry line and 
select "Loop Back" from the popup menu. 

4. The Loopback dialog box appears. Enter the name of the Diagnostic H.323 Terminal ID 
in the text field. 

 
5. Click the Start Loopback button. After the Loopback test starts, the Board Status 

changes to Loopback, and the push button caption changes to "Stop Loopback." 

6. To stop the Loopback test, click the Stop Loopback button. 

If the LiveGateway board is in a download or self-test state, you cannot run the loopback test, and the Start 
Loopback selection on the Operations menu selection appears dimmed. 

 



Viewing the POST Result 
To view the Power On Self Test (POST) result for the selected LiveGateway Board: 

1. Open the LiveGateway server from the LiveGateway SNMP Manager window. 

2. Select the Gateway Boards tab of the LiveGateway Server window. 

3. Perform one of the following actions: 

• Click on a board in the list to highlight the board, and select Operations-> Show 
POST Result...  from the LiveGateway Server window's menu bar.  

• Right-click your mouse when it is positioned over the board's entry line and 
select "Show POST Result..." from the popup menu. 

 
4. Click the OK button to exit this message box. 

 

Viewing LiveGateway Board Statistics 
The statistics displayed in LiveGateway's Statistics window provides information that can be used to monitor 
the system performance of the LiveGateway server.  

To view the statistics: 

1. Open the LiveGateway server from the LiveGateway SNMP Manager window. 

2. Select the Gateway Boards tab of the LiveGateway Server window. 

3. Perform one of the following actions: 

• Click on a board in the list to highlight the board, and select Operations-> Show 
Statistics from the LiveGateway Server window's menu bar.  

• Right-click your mouse when it is positioned over the board's entry line and 
select "Show Statistics" from the popup menu. 

4. The Statistics for the selected LiveGateway Board are displayed in the Statistics 
window.  



 
5. To close the Statistics window, click the [X] in the upper right-hand corner. 

Viewing Board Settings and Version Information 
Information about the LiveGateway board is important when you encounter problems that you cannot correct 
and need to report them to PictureTel.  

To view board settings and version information:  

1. Open the LiveGateway server from the LiveGateway SNMP Manager window. 
2. Select the Gateway Boards tab of the LiveGateway Server window. 
3. The following information is displayed for each board in the Gateway Boards tab: 

• Status 
• Interface 
• I/O Address 
• IRQ (Interrupt) 
• Hardware Version Number 

To view software version and Gatekeeper information:  

1. Open the LiveGateway server from the LiveGateway SNMP Manager window. 
2. Click the Settings tab to see the following information: 

• LiveGateway Software Version Number 
• Gatekeeper Name or Address 



Using PictureTel LiveGateway 
 

Overview  
With PictureTel LiveGateway installed on a server, LiveLAN and NetConference users and other H.323 
terminals can place calls to H.320 clients and to other LiveLAN and NetConference users across an ISDN 
WAN. LiveGateway is connected to the WAN by an internal ISDN BRI interface and to the LAN by the server 
on which it resides.  

By registering with LiveManager as a special terminal, LiveGateway lets H.323 clients access the WAN. 
LiveGateway always uses the H.320 protocol in its connection to the WAN. It translates video, audio, and 
shared application data from the H.323 protocol to the H.320 protocol. 

This section describes how to place calls through LiveGateway and manage operator station information. It also 
describes how to use the LiveGateway Audio Clip Recorder to record customized versions of the LiveGateway 
automated attendant audio messages. The LiveGateway Audio Clip Recorder is automatically installed when 
LiveGateway is installed on your server.  

The information that describes how to use PictureTel LiveGateway  is organized into the following categories.  

• Placing calls through LiveGateway 
• Outgoing Calls 
• Incoming Calls 
• DTMF Calls 
• Operator-assisted Calls 
• A Sample Configuration 
• A Typical Calling Scenario for a LiveLAN Client and H.320 Terminal 
• Managing Operation Station Information 
• Adding an Operator Station 
• Changing an Operator Station 
• Using the LiveGateway Audio Clip Recorder 

 

Placing Calls through LiveGateway 
With LiveGateway, LiveLAN clients and NetConference users can place calls to H.320 terminals and to other 
LiveLAN clients over an ISDN WAN. The connection is transparent and gives users access to a larger 
conferencing community.  

Note: Since LiveManager cannot accurately detect if a LiveGateway’s ISDN line is active, it is 
recommended that you disable any installed LiveGateways which do not have working ISDN lines, so 
that other LiveGateways on the server, or on other servers, can be accessed. 

Note: If you have problems placing a LiveGateway call in a system configuration utilizing two or more 
LiveGateways, carefully review the data recorded in the LiveGateway event log file. The information in 
this log is helpful for both identifying and resolving issues such as an ISDN line that may be inactive 
when it is not in use. 



Outgoing Calls 

When a user makes a LAN to WAN call, LiveManager checks for available resources and passes the call to 
LiveGateway. If there is more than one LiveGateway installed on a server, LiveManager uses the bandwidth 
information to determine which LiveGateway will complete the call.  

If bandwidth checking has been enabled, LiveManager chooses available LiveGateways by location (closest to 
farthest). If bandwidth checking has been disabled, LiveManager chooses available LiveGateways by order of 
registration (first to last).  

Incoming Calls 

LiveGateway allows LiveLAN clients to receive two types of calls from H.320 and other LiveGateways:  

1. DTMF 
2. Operator-assisted 

DTMF Calls 

DTMF is an abbreviation for Dual-Tone Multiple Frequency -- the telecommunications scheme that encodes 
digits using the sounds generated by push-button telephones. The following PictureTel systems support DTMF:  

• PictureTel Live 50™ (all versions) 
• PictureTel Live 100™ (all versions) 
• PictureTel Live200™ (version 1.1) 
• PictureTel SwiftSite™ (all versions) 
• PictureTel Venue 2000™ (all versions) 
• PictureTel Concorde 4500™ (version 6.10 or later) 

Note: Users placing calls from terminals that do not support DTMF can either place a pocket dialer next 
to the microphone of the terminal making the call or use operator assistance. For more information, refer 
to Operator-assisted Calls.  

Note: When sending DTMF tones to LiveGateway, it is important that the H.320 system is not muted. If 
the H.320 system is muted, the tones will not be sent to LiveGateway, even through they are audible 
(can be heard) from the H.320 system’s speakers.  
  

When LiveGateway receives a call from an H.320 user with DTMF:  

1. LiveGateway prompts the H.320 user (via an audio prompt) to enter the H.323 Terminal ID of the 
destination client. 

2. The user enters the H.323 Terminal ID, and the terminal sends the ID as DTMF tones through its audio 
channel. 

3. LiveGateway converts the tones to digits. 
4. LiveGateway and Live Manager use the digits to request connection to the LiveLAN client. 
5. If LiveManager cannot find the LiveLAN or H.323 client, the call is disconnected, unless operator-

assistance is used, in which case, the call is forwarded to the operator station. 

When LiveGateway receives a call from an H.320 user without DTMF:  

1. LiveGateway prompts the H.320 user to enter the H.323 Terminal ID of the destination client. 



2. If no tones are received within 30 seconds, the call is routed to the H.323 client designated as the 
operator station. If an H.323 Terminal that supports call transfer, such as LiveLAN, is being used as the 
operator station, an operator (person) asks for the name or H.323 Terminal ID, and then transfers the call 
normally. If an operator station is not specified, the call is disconnected. 

Note: Any PictureTel LiveLAN Terminal can be designated as an operator station. Other H.323 
terminals, however, may not support this function. 

  

Operator-assisted Calls 

When a LiveLAN client is designated as an operator station, LiveGateway directs incoming calls requiring 
operator assistance to that station. Calls without DTMF are examples of calls that require operator assistance.  

To designate a LiveLAN client as an operator station, the LiveManager administrator must enter the H.323 
Terminal ID of the client into the LiveManager operator station mapping file.  

When an incoming H.320 call requires operator assistance, LiveGateway uses the information in the 
LiveManager mapping file to pass the call to the operator station. From there, the operator transfers the call 
using LiveLAN’s call transfer capability. For more information, refer to the PictureTel LiveManager Product 
Guide.  

If an operator station is not specified in the LiveManager operator station mapping file, the call will be 
disconnected if:  

• The H.320 terminal does not have DTMF capability. 
• The H.320 terminal has DTMF capability, but the caller does not know the destination H.323 Terminal 

ID. 
• An incorrect H.323 Terminal ID is entered. 

  

The "Always Use Operator Station" Feature 

You can configure LiveGateway to use the Operator Station to answer all incoming LiveGateway calls by 
enabling the "Always Use Operator Station" checkbox on the LiveGateway Configuration utility window when 
you install LiveGateway. The feature is enabled when a checkmark appears in the checkbox. The system default 
for this feature is set to disabled. Click on it to enable it. Refer to Running the LiveGateway Configuration 
Utility for specific information on how to change LiveGateway board configuration information. 

 

Sample Configuration  
The following diagram shows a sample configuration consisting of an ISDN WAN, a LiveGateway, LiveLAN 
clients, and an H.320 client.  

  



 

In this sample configuration:  

• There are two network segments, each with one router.  
• LiveManager is running on Server A with a network topology map.  
• Server C has a LiveGateway connected to a dial-up ISDN BRI line.  
• LiveLAN Client S and H.320 Terminal Z can participate in a video call through LiveGateway. 

A Typical Scenario for Calls Between a LiveLAN Client and an H.320 Terminal When LiveLAN Client S calls 
H.320 Terminal Z:  

1. Client S sends a call request to the LiveManager with which it is registered. The call 
request packet includes the following ISDN WAN information: 

• Two phone numbers, such as 9700-731-1234 and 9700-731-1234. Because you 
are using an ISDN BRI line, the two numbers you specify may be the same. For 
more information about ISDN BRI, refer to Preparing Board Configuration 
Information.  

• WAN channel rate, such as 2x64 kbps. 

2. LiveManager receives this request and, because the call request includes the Gateway 
Prefix (in this example, “9”), LiveManager finds the LiveGateway closest to Client S. 

3. If bandwidth control is enabled, and the bandwidth is sufficient for a call between Client 
S and LiveGateway, LiveManager forwards the call request packet, including the WAN 
information to LiveGateway. 

4. LiveGateway uses the WAN information to dial out to the ISDN WAN. 
5. When destination Terminal Z answers the call, H.320 communication begins and 

LiveGateway notifies LiveManager that the call is connected. 
6. LiveManager completes the call between Client S and LiveGateway. 

 



Managing Operator Station Information 
You can specify a LiveLAN user, or another H.323 client that supports call transfer, as an operator station to 
transfer incoming calls from H.320 terminals to their destination LiveLAN clients. LiveGateway uses operator 
assistance for calls dialed through an ISDN WAN to a LiveLAN client if:  

• The calling H.320 terminal does not have Dual-Tone Multiple Frequency (DTMF) capability. 
• The caller does not know the H.323 Terminal ID. 

Calls that are operator-assisted are passed directly to a LiveLAN client designated as the operator station in 
LiveManager’s operator station mapping file. If an operator station is not specified, the call is disconnected. If 
an operator station is specified, an operator answers the call, asks the caller for the name or ID number of the 
recipient LiveLAN client, and transfers the call to the appropriate LiveLAN client by using LiveLAN’s call 
transfer feature.  

You can add and change an operator station. To make a LiveLAN client the operator station, specify the 
Terminal ID of the LiveLAN client in the LiveManager operator station mapping file.  

 

Adding an Operator Station 
To add an operator station:  

1. Click the Operator Station... button located in the Gateway area of the LiveManager Console 
window. The Add Operator Station dialog box appears. 

2. Enter the ID of the H.323 Terminal client you want to designate as the operator station. 
3. Click OK. 

 

Changing an Operator Station  
To change the LiveLAN client designated as the operator station:  

1. Click the Operator Station... button located in the Gateway area of the LiveManager Console 
window. The Modify Operator Station dialog box appears. 

2. Enter the ID of the H.323 Terminal client you want to designate as the operator station. 
3. Click OK. 

 

Using the LiveGateway Audio Clip Recorder 
The LiveGateway Audio Clip Recorder utility is installed automatically during the LiveGateway software 
installation process, and is accessible from the LiveGateway Group on the Windows NT Taskbar. Use this 
program when you want to customize any of the seven audio clips (messages) used by the LiveGateway 
automated attendant. The LiveGateway automated attendant provides call status feedback to a calling H.320 
system. 



NOTE: This utility (and associated files) may also be copied from the "Tools\GwSnd Recorder" directory of 
the Installation CD-ROM to another PC running Windows 95 or NT. This may be necessary if the LiveGateway 
Server is not equipped with audio record and playback capabilities. 

  

Audio Clips 

The seven automated attendant audio clip types customizable from the LiveGateway Audio Clip Recorder 
include:  

• Welcome  
• Connect  
• Busy  
• No Answer  
• Unrecognized or Invalid  
• Operator  
• Locked Conference  

Welcome Message 

The Welcome message is played to the H.320 system caller by the LiveGateway automated attendant when the 
initial call is received by LiveGateway. The message tells the caller that he/she has reached the LiveGateway 
automated attendant. The message then explains to the caller how to place the call and how the call is processed 
and directed by LiveGateway. 

Connect Message 

The Connect message is played to the H.320 system caller by the LiveGateway automated attendant when the 
call connection is being established. 

Busy Message 

The Busy Message is played to the H.320 system caller by the LiveGateway automated attendant when the call 
can't be completed because the number (extension) being called is busy.  

No Answer Message 

The No Answer message is played to the H.320 system caller by the LiveGateway automated attendant when 
the number being called doesn't respond and the call is not answered. 

Unrecognized or Invalid Message 

The Unrecognized or Invalid message is played to the H.320 system caller by the LiveGateway automated 
attendant when the number that the caller entered is not recognized by LiveGateway. 

Operator Message 

The Operator message is played to the H.320 system caller by the LiveGateway automated attendant when the 
caller is being transferred to the operator. 



Locked Conference Message 

The Locked Conference message is played to the H.320 system caller by the LiveGateway automated attendant 
when an attempt is made to dial into a PictureTel H.323 MCU multipoint conference that is locked. 

 

Audio Clip Statistics 
The following statistics are displayed for each audio clip:  

• Maximum Length  
• Current Length  
• Current Position  

These statistics are displayed in the center portion of the LiveGateway Audio Clip Recorder application 
window. 

 

  

Maximum Length 

The Maximum Length (in seconds) of the selected audio clip. 

Current Length 

The current length (in seconds) of the audio clip being recorded. The values in this window change only when 
an audio clip is being recorded. 

Current Position 

The current position (in seconds) of the audio clip being recorded or played back. 

 



Procedure for Using the LiveGateway Audio Clip Recorder 
The following steps describe how to use the LiveGateway Audio Clip Recorder: 

Note 

To use this program, you must have a Windows NT-compatible microphone, sound card, and 
speakers configured on your server. If your server is not equipped with audio record and playback 
capabilities, the LiveGateway Audio Clip Recorder utility (and its associated files) can be copied 
from the "Tools\GwSndRecorder" directory of the installation CD-ROM to another PC running 
Windows 95 or NT. 

  

1. Choose -> Start -> Programs -> PictureTel LiveGateway -> LiveGateway Custom Audio Clip Utility 
from your Windows NT desktop. 

2. The LiveGateway Audio Clip Recorder application window is displayed. To record a new audio clip, 
select the appropriate Audio Clip Type from the Audio Clip Type dropdown list. 

3. Click the Record button to record your message. Speak into your microphone to begin recording your 
new audio clip.  

Note: Each audio clip has a maximum message length (in seconds) that can be recorded. Do not exceed 
this length when recording your audio clip. 

4. When you're done recording your audio clip, click the Stop button. 

5. To playback and listen to the audio clip you just recorded, click the Play button. 

6. If you want to change the audio clip again, click the Record button and enter your new message. 

7. To save your audio clip, click the Save button. A message box will appear warning you that an existing 
audio file is about to be overwritten. If you don't want to overwrite the existing audio file, click the "No" 
button and follow the directions in the dialog box to save it to another folder. Click the "Yes" button to 
overwrite the existing audio file. 

8. To exit the LiveGateway Audio Clip Recorder program, select File -> Exit from the menu bar, or click 
the closebox [X] in the upper right hand corner of the LiveGateway Audio Clip Recorder titlebar. 

By default, a customized audio clip will replace the existing version of that type located in the LiveGateway 
installation folder (directory). The LiveGateway Audio Clip utility also allows you to save customized audio 
clips to an alternate folder. Please note that the "active" audio clips must be stored in the LiveGateway 
installation folder. Any clip stored in an alternate directory must be subsequently copied to the LiveGateway 
installation folder in order to be played back to a calling H.320 system. 

 



Menu Bar 
The LiveGateway Audio Clip Recorder menubar contains two selections:  

1. File  
2. Help 

  

File 

From the File menu, you can select the folder for storing/saving your audio clip files or exit (quit) the program.  

Select Audio File Folder 

You may wish to save your customized audio clips (*.aud extension) to a folder other than the LiveGateway 
installation folder. Use the Select Audio File Folder option to select the folder for storing your audio clips. 

Note 

The "active" audio clips that you wish to use must be stored in the LiveGateway installation 
folder. If you recorded these clips on another PC because your server does not have audio record 
and playback capabilities, make sure you place these files into the LiveGateway installation folder 
on your server. 

You can also use the Select Folder dialog box to perform standard Windows Explorer operations such as 
renaming or copying audio files, etc. Select a file and then right-click on it with your mouse. A popup window 
appears that lists all of the operations you can perform. 

  

Help 

From the Help menu, you can access the online Help Topics for the LiveGateway Audio Clip Recorder. If you 
want to access version number information, select the About option from the Help menu. 



Line Information for ISDN BRI Service 
 

Overview 
The following tables list the LiveGateway requirements for the most common U.S. central office switches and 
the European switches. The most common US central office switches include the AT&T 5ESS, Northern 
Telecom DMS-100, and Siemens switch types. European switches include the ITR6 (Germany), NET 3 (Italy), 
NET3 (United Kingdom), and VN3 (France) switch types 

Click on the following links for more information.  

• AT&T 5ESS Switch Line Information 
• Northern Telecom DMS-100 Switch Line Information 
• Siemens Switch Line Information 
• European Line Information 
• Ordering ISDN Service in the United States 
• 5ESS Switch Information 
• DMS100 Switch Information 
• EWSD NI1 Switch Information 

 

AT&T 5ESS Switch Line Information 

Requirements  For National ISDN 
Service  For Custom ISDN Service  

   

Line Code  2B1Q  2B1Q  

Digital Subscriber 
Line  Multipoint  Point-to-point or  

multipoint  

Software Release  5E8 or higher  5E6 or higher  

Service Provider ID 
(SPID)  

1 or 2 (determined by 
your  
telephone company)  

Not needed for point-to-point; 1 or 2 
needed for multipoint  

Directory Numbers 
(DNs)  

1 or 2 (determined by 
your  
telephone company)  

1 or 2 (determined by your  
telephone company)  



B1 Service  DMD  DMD  

B2 Service  DMD  DMD  

D Channel  Signaling only  Signaling only  

CSV  1  1  

CSV Channel  Any  Any  

CSD  2  2  

CSD Channel  Any  Any  

CSD Limit  2  2  

TEI  Dynamic  Dynamic  

MAXB Channel  2  2  

MTERM  2  1 if one DN, 2 if two DNs  

Terminal Type  A  A  

ACT USR  Yes  Yes  

 

Note: The number of SPIDs must equal the number of DNs.  

 

Northern Telecom DMS-100 Switch Line Information  

Requirements  For National ISDN 
Service  

For Custom ISDN 
Service  

   

Line Code  2B1Q  2B1Q  

Load  BCS-35  BCS-33  



Service Provider ID (SPID)  2  2  

Directory Numbers (DNs)  2  2  

B1 Channel Circuit Switch  Yes  Yes  

B1 Channel Bearer 
Restriction  No PMD  No PMD  

B1 Channel Terminal 
Adapter  Functional  Functional  

B1 Channel TEI  Dynamic  Dynamic  

B1 Channel Ring  Yes  Yes  

B1 Channel EKTS  No  No  

B1 Channel Data Option  PROVLLC CMDATA  -  

B2 Channel Circuit Switch  Yes  Yes  

B2 Channel Bearer 
Restriction  No PMD  No PMD  

B2 Channel Terminal 
Adapter  Functional  Functional  

B2 Channel TEI  Dynamic  Dynamic  

B2 Channel Ring  Yes  Yes  

B2 Channel EKTS  No  No  

B2 Channel Data Option  PROVLLC CMDATA  -  

 

Line Information  for the Siemens Switch  

NPA = 815  DN = 3337890  EQN = 20- 0- 3- 4-  



CAT  IBA   

BCHDN  2   

BCDN  C56 and C64   

CT  CMD   

BCHCT  2   

IBCHCT  2   

OBCHCT  2   

ORIG1  1   

PIC  0288 - C56 and 0288 - C64   

CHRG  FRSA1   

COS  ACOU and ICND and RND   

CRBLIM  16   

ACOLIM  15   

   

NPA = 815  DN = 3337891  EQN = 20- 0- 3- 4-  

CAT  IBA   

BCHDN  2   

BCDN  SP and AU3   

CT  VI   

BCHCT  2   

IBCHCT  2   



OBCHCT  2   

CHRG  FRSA1   

COS  NOICND and NRND   

CRBLIM  2   

   

Terminal Service Profile Data  

View  TSP,   

EQN  20- 0- 3- 4-,   

USID  1,   

TSPID  815333789001,   

TERMLIM  1,   

TSPCOS  CMDBCHR;   

VIEW  TSPDNCT,   

EQN  20- 0- 3- 4-,   

TSPID  815333789801,   

NPA  815,   

DN  3337890,   

CT  CMD,   

FKMPINUM  0,   

   

 



   

Access Data  

EQN  20- 0- 3- 4-,   

CLOSS  0,   

BCHEQN  2.   

BCEQN  SP and AU3 &C56 and C64 and PMD  

CPDDN  8153337890 and 8153337890 - CMD and 8153337890 - PMD,  

CPVDN2  8153337890 and 8153337891 - VI,  

COE  CLASS1,   

LINKOPT  DYNNOPAL,   

BAPROF  0,   

Note:  

The SPID number field should contain only numbers. Do not enter dashes or other characters. 
An example of a correct SPID is 001332783401. If the telephone company gives you two 
identical SPIDs, enter the SPID only once, in the first SPID Number field. Leave the second 
field blank. Number Type and Number Plan should always be set to Not Used in the United 
States.   

 

European Line Information 
You will need to provide the following ISDN BRI line information when you install the LiveGateway software. 
If you don’t have this information, it can be obtained from your service provider:  

• Signaling protocol (switch type), which can be: 

• ITR6 (Germany) 
• NET3 (Italy) 
• NET3 (United Kingdom) 
• VN3 (France) 

• Number type and number plan. Refer to the following chart for the values to enter. 

  



  

Switch Type 
Number Type  Number Plan 

VN3 in France  Unknown  Unknown  

ITR6 in Germany  Unknown  ISDN  

All other types  Not used  Not used  

 

Ordering ISDN Service in the United States 
An ISDN BRI line is needed to operate PictureTel LiveGateway. An ISDN BRI line can take several weeks to 
install from the time you place the order; therefore, plan ahead. Also, make sure you know whether you need an 
NT1 line. 

Information You Need From Your Telephone Company 

You need the following information from your telephone company:  

• The type of central office switch in use in your area. The most common switch types are 5ESS, 
DMS100, and EWSD NI1 (as shown in the following tables). 

• The type of ISDN service available in your area. Two of the most common types are Custom or National 
(as shown in the following tables). If Custom service is available, find out if it is a point-to-point or a 
multi-point connection. 

• Your dialing number. 
• Your Service Provider Identification Number (SPID), if applicable. 

 

Information You Can Provide to Your Telephone Company 
The line provisioning requirements for PictureTel LiveGateway are listed in the following tables. To help 
expedite the ISDN line installation process, please provide this information to your telephone company. 

5ESS Switch Information 

  

Custom 

Version 5E6 
or Higher* 

Point-to-Point 

Custom 

Version 5E6 
or Higher* 

Multipoint 

National 
ISDN 

(NI1 and 
NI2) 

National 
ISDN 

(NI1 and 
NI2) 

Version 
5E8 or



5E8 or 
Higher** 

NI2 (1DN) 

Higher** 
NI1 (2 DNs) 

Line Code  
Digital 
Subscriber 
Line (DSL)  

2B1Q Point-to-
Point  

2B1Q 
Multipoint 

2B1Q* 
Standard 

2B1Q* 
Standard 

Service 
Provider ID 
(SPID)  

Not needed for 
this 
configuration  

Two required  
One assigned 
by telephone 
company  

Two assigned 
by telephone 
company.  

Directory 
Numbers 
(DN)  

One is assigned 
for both B-
channels  

Two required. 
One for each B-
channel  

One is 
assigned for 
both B-
channels  

Two (one for 
each B-
channel)  

Provisioning 
Parameters      

DSL CLS  Point-to-Point  Multi-point    

B1 SERV  
DMD for circuit 
switched 
voice/data  

DMD for 
circuit switched 
voice/data  

DMD for 
circuit 
switched 
voice/data  

DMD for 
circuit 
switched 
voice/data  

B2 SERV  DMD for circuit 
switch data  

DMD for 
circuit switch 
data  

DMD for 
circuit switch 
data  

DMD for 
circuit switch 
data  

D-Channel  
Signaling only 
(no packet-
switched data)  

Signaling only 
(no packet-
switched data)  

Signaling 
only (no 
packet-
switched 
data)  

Signaling 
only (no 
packet-
switched 
data)  

CSV  1  1  1  1  

CSV CHL  B1  B1  B1  B1  

CSD  2  2  2  2  



CSD channel  Any  Any  Any  Any  

CSV LIMIT  1  1  1  1  

CSD LIMIT  2  2  2  2  

MAXB CHNL 
(maximum B-
channel)  

Must be set to 
2.  

Must be set to 
2.  

Must be set to 
2  

Must be set to 
2  

MTERM  1  2  2  2  

TERMTYP 
(Terminal 
type)  

Type A  Type A  Type A  Type A  

ACT USR  Must be set to 
YES  

Must be set to 
YES  

Must be set to 
YES  

Must be set to 
YES  

  

* Software releases prior to 5E6 (5E5 and 5E4.2) support only AMI line coding.  

** NI-1 was first supported in the 5E8 software release.  

Note:  

Most SPIDs have one of the following formats: 01-7 digit DN, and an optional digit (for example, 01-
332-7834-1, or any 3 digits (usually an area code), 7 digit DN, additional optional digits (for example, 
700-737-3290-01).  

 

DMS100 Switch Information 
   

 
Custom Load BCS-33 

(PVC-1) 

National 

ISDN-1 (NI-1) 

Load BCS-35 

Line Code  
Di it l S b ib 2B1Q  2B1Q*   

   



Line (DSL)  

Service Provider ID 
(SPID)  
   

Directory Numbers 
(DN)  

Two  

Two  

Two  
   

Two (one for each B-channel)  

Provisioning 
Parameters    

 B1  B1  

 Set circuit switch to Yes  Set circuit switch to Yes  

 Set Bearer Restriction to 
NOPMD (No Packet Data)  

Set Bearer Restriction to NOPMD 
(Must be set to 2)  

 Functional Terminal 
Adapter  Functional Terminal Adapter  

 Set TEI to Dynamic  Set TEI to Dynamic  

 Set Ring to Yes  Set Ring to Yes  

 Set EKTS to No  Set EKTS to No  

  
Set data option: PROVLLC 
CMDATA (lower layer 
compatibility)  

 B2  B2  

 Set circuit switch to Yes  Set circuit switch to Yes  

 Set Bearer Restriction to 
NOPMD (Must be set to 2)  

Set Bearer Restriction to NOPMD 
(Must be set to 2)  

 Functional Terminal 
Adapter  Functional Terminal Adapter  

 Set TEI to Dynamic  Set TEI to Dynamic  



 Set Ring to Yes  Set Ring to Yes  

 Set EKTS to No  Set EKTS to No  

  
Set data option: PROVLLC 
CMDATA (lower layer 
compatibility)  

  

 

EWSD NI1 Switch Information 
   

Line Code  
Digital 
Subscriber Line 
(DSL)  

2B1Q  
National*  

Provisioning 
Parameters  BCHDNs = 2 (directory numbers assigned by telephone company)  

 BCDN = C56  

 BCDN = C64 (if supported by inter-exchange carrier to local central 
office)  

 CT = CMD (circuit mode data)  

 TSPIDs assigned by telephone company: Two  

 BRI should be provisioned as follows:  

 Subscriber  

 - Set B1 CT = CMD (for circuit switched data/voice)  

 - Set B2 CT = CMD (for circuit switched data)  

 - BCHCT = 2  



 - IBCHCT = 2  

 - OBCHCT = 2  

 - COS = NICND (class of service; no ISDN calling # delivery)  

 - PIC = XXX-C56 (where XXX is the inter-exchange carrier's code)  

 - PIC = XXX-C64 (where XXX is the inter-exchange carrier's code)  

Terminal Service 
Profile Data:  

- USID = 1 (user ID)  
- TSPID = 7085551234001 (for illustration purposes)  

 - TERMLIM = 1 (maximum number of terminals that can share this 
SPID)  

 - CT = CMD  

 - FKMPINUM = 0 (feature key management profile index number)  

Access Data:  - BCHEQN = 2 (number of B-channels assigned)  

 - BEQN = SP & AU3 & C56 & C64 (bearer capabilities on BRI)  

 - COE = CLASS1 (class of equipment)  

 - LINKOPT = DYNNOPL (dynamic link, no packet links)  

 

- CPDDN = 7085551234-CMD - The directory numbers assigned by the 
telephone company must match the bearer capabilities requested. In this 
example, the single number listed is for circuit mode data. For this 
application, two DN's are requested.  

 - CPVDN2 = 7085551235  

  

* NI1 was first supported in the APS 11 software release.  

Note: Some fields might vary from one switch to another. Voice DN might be different from CMD DN.  

 



I/O Port Base Address Settings 
 

Overview 
This appendix lists the I/O Port Base Address settings that can be selected for the LiveGateway board. The 
board’s I/O port address is set by DIP Switch, DS-1, which is located just below the BRI module on the board.  

The default I/O port base address setting, as configured on the LiveGateway board’s DIP switch for the 
LiveGateway board is 380 (hexadecimal). The following illustration shows the default DIP switch settings for 
each of the two types of LiveGateway DIP switches used with the LiveGateway board. Your LiveGateway 
board will have one of these DIP switches 

 

NOTE: 
You can view the DIP switches in this upright way only if the board is 
not installed in the PC. When the board is installed in the PC, the DIP 
switches appear upside-down. 

  

If the default address conflicts with the I/O address of another device, reset the DIP switches to a different value 
before installing the LiveGateway board in the PC. Use a paperclip to change the settings of the DIP switch to 
the new I/O port base address. 

The following illustration shows an example of how the DIP switch is oriented on the LiveGateway board. 
Please note that this illustration shows one of the two types of DIP switches that are used on the LiveGateway 
board. Your board may have the other type of DIP switch, but their operation and switch settings are identical. 

  

 

NOTE: 
You can view the DIP switches in this upright way only if the board is 
not installed in the PC. When the board is installed in the PC, the DIP 
switches appear upside-down. 



Switch 1 corresponds to the least significant bit of a block of 32 byte I/O port addresses. When it is in the off 
position, it sets bit 5 of the address, and its numerical weight is 20 hexadecimal. Switch 5 corresponds to the 
most significant bit of a block of 32 byte I/O port addresses. When it is in the off position, it sets bit 9 of the 
address, and its numerical weight is 200 hexadecimal.  

NOTE: 
I/O addresses below 100 hexadecimal are reserved for the system board 
of the host computer. Setting the LiveGateway board I/O address below 
100 hexadecimal may interfere with the operation of the host computer. 

 

I/O Port Base Address Settings 
The following table lists the values for the I/O port base addresses and their corresponding DIP Switch 
positions. 

On (1) Switch Position  
I/O Port Base Address (hexadecimal) 

Off (0) 1 2 3 4 5 

1    X  
100 

0 X X X  X 

1 X   X  
120 

0  X X  X 

1  X  X  
140 

0 X  X  X 

1 X X  X  
160 

0   X  X 

1   X X  
180 

0 X X   X 

1 X  X X  
1A0 

0  X   X 

1  X X X  
1C0 

0 X    X 

1 X X X X  
1E0 

0     X 



1     X 
200 

0 X X X X  

1 X    X 
220 

0  X X X  

1  X   X 
240 

0 X  X X  

1 X X   X 
260 

0   X X  

1   X  X 
280 

0 X X  X  

1 X  X  X 
2A0 

0  X  X  

1  X X  X 
2C0 

0 X   X  

1 X X X  X 
2E0 

0    X  

1    X X 
300 

0 X X X   

1 X   X X 
320 

0  X X   

1  X  X X 
340 

0 X  X   

1 X X  X X 
360 

0   X   

1   X X X 
380 

0 X X    

3A0 1 X  X X X 



 0  X    

1  X X X X 
3C0 

0 X     

1 X X X X X 
3E0 

0      

 



Using The LiveGateway Event Log 
 

Overview 
LiveGateway stores informational messages, tracking messages, warning messages, and error messages in an 
event log. The information in the event log helps you to monitor LiveGateway traffic. The event log can be 
viewed using the LiveGateway configurator or any application which is capable of displaying a text file, such as 
Notepad.  

You can also view and manage LiveGateway from the LiveManager console via the LiveGateway SNMP 
Manager. From the LiveGateway SNMP Manager window you can access LiveGateway Servers and:  

• View LiveGateway statistics 
• Perform diagnostic tests 
• View settings 

 

ISDN Cause Codes are also placed in the event log. Whenever the ISDN network disconnects (or rejects) a call, 
it generates a Q.931 Cause Code. This code message is placed into the LiveGateway Event Log so that the 
message will be printed out and available to the administrator for help in troubleshooting 
installation/configuration issues and diagnosing ISDN line problems.  

 

Viewing the Event Log to Troubleshoot LiveGateway 
The event log file is named tmmddyy.log. A new event log is created for each day of operation. It contains 
event codes, event categories, and text descriptions for messages. Open tmmddyy.log and locate the code and 
category for your problem. Find that same event code in the appropriate table contained in Using the 
LiveGateway Event Log Information to locate the possible cause and the possible solution.  

Location of Event Log 

The LiveGateway event logs are located in the directory where LiveGateway was installed. This directory can 
be shared so that client PCs can map it to a local drive, enabling remote viewing of the logs.  

Event Log Format 

Each line in the event log is a unit of information. The following is a sample line from a event log  

 



Date and Time 

The date is the month and day that LiveGateway generated the message. The time is the hour and minute that 
LiveGateway generated the message.  

Event Code 

The event code is a code for the message. Refer to Using the Event Log Information for details on the event 
codes.  

Category 

The category is the class of the message. There are six categories:  

1 = Informational, such as reporting that LiveGateway has started.  

2 = Accounting, such as reporting that a call has been established.  

3 = Warnings, where no problem will occur if the message is ignored.  

4 = Minor Alarms, where a problem may occur if the message is ignored.  

5 = Major Alarms, where a serious problem may occur if the message is ignored.  

6 = Fatal Errors, where LiveGateway shuts down to prevent any serious problems. 

Description 

The description provides brief information about the event.  

 

Using the LiveGateway Event Log Information 
The following information describes the six categories of LiveGateway messages recorded in the LiveGateway 
event log, and the recommended action for each message.  

Informational Messages 

The following table shows Category 1 (informational) messages that appear in the event log and the 
recommended action for each message.  

Event 
Code 

Description Probable Cause 
Possible 
Solution 

0x0001  
PictureTel 
LiveGateway started 
i fil

LiveGateway started for 
the first time.  No action required.  



name  

0x0002  

PictureTel 
LiveGateway shut 
down in file server: 
server name  

LiveGateway has shut 
down normally (that is, a 
user has unloaded 
LiveGateway from the 
server) or abnormally 
(for example, a fatal 
error). If a fatal error has 
occurred, this message is 
preceded by a fatal error 
message.  

For normal unloading, 
no action required. For 
abnormal unloading, 
refer to the information 
about the fatal error 
message preceding this 
message.  

0x0003  
Old event log file 
was deleted: 
filename  

LiveGateway deleted the 
specified event log.  No action required.  

0x0200  

POST successful, 
but card not 
responding. Try 
another IRQ 
selection.  

Auto-detection of IRQ 
conflict not functioning 
properly.  

Choose a different IRQ.  

0x0201  
Possible 
LiveGateway 
hardware failure  

The LiveGateway card is 
not responding to 
download commands. 
Possible hardware 
problem.  

Verify software disk 
integrity and try to 
reinstall. If error 
reoccurs, contact 
PictureTel.  

0x0202  File downloaded to 
LiveGateway  

The file was successfully 
downloaded to the 
LiveGateway card.  

No action required.  

0x0300  
LiveGateway 
hardware setting: 
value  

Hardware configuration 
may conflict.  

Choose a new I/O or 
IRQ setting.  

0x0400  
LiveGateway 
received unregister 
command  

LiveGateway Console 
commanded 
LiveGateway to go off-
line.  

No action required.  

0x0401  

LiveGateway 
received inactive 
command from 
SDC  

LiveGateway card about 
to reset. Self-test button 
pressed on LiveGateway, 
or LiveGateway service 
stopping.  

No action required.  



0x0402  LiveGateway going 
to RESET state  

LiveGateway card about 
to reset. Self-test button 
pressed on LiveGateway, 
or LiveGateway service 
stopping.  

No action required.  

0x0403  LiveGateway going 
to IDLE state.  

System initialization 
complete, or previous 
call has ended.  

No action required.  

0x0404  
LiveGateway going 
to AWAITING 
TICL START state  

LiveGateway attempting 
to register with 
gatekeeper.  

No action required.  

0x0500  
Registration with 
gatekeeper 
succeeded  

LiveGateway attempting 
to register with 
gatekeeper.  

No action required.  

0x0501  
Unregistration with 
gatekeeper 
succeeded  

LiveGateway going off-
line, service stopping  No action required.  

0x8002  
ISDN Link State (1 
= Up, 0= Down): 
value  

Status of LiveGateway's 
ISDN network.  

If the value is 0, check 
the ISDN connection, 
and notify your service 
provider. Also, use the 
LiveGateway 
Configuration utility to 
disable this gateway 
board. Refer to the 
"state" description in the 
LiveGateway Installation 
Guide. 

0x80B0  

ISDN Call 
Disconnected: Q.931 
Raw Cause Code 
value  

Informational. Can help 
troubleshoot ISDN 
configuration issues.  

No action required.  

 

Accounting Messages 
The following table shows Category 2 (accounting) messages that appear in the event log and the recommended 
action for each message.  

Description Possible Cause 



Code Solution 

0x0420  
LiveGateway Attempting 
inbound call to terminal 
ID  

H.320 system attempting to 
connect to H.323 terminal.  

No action 
required.  

0x0421  H.320 call successful for 
LiveGateway  

LiveGateway successfully 
completed call to H.320 system.  

No action 
required.  

0x0422  
LiveGateway received 
H.320 disconnect - reason 
code  

H.320 system disconnected call 
with LiveGateway.  

No action 
required.  

0x0423  
LiveGateway going to 
ATTEMPT OUTBOUND 
CALL state  

LiveGateway trying to call 
H.320 system.  

No action 
required.  

0x0424  
LiveGateway going to 
ATTEMPT INBOUND 
CALL state  

LiveGateway trying to call 
H.323 system.  

No action 
required.  

0x0425  LiveGateway going to IN 
CALL state  

LiveGateway call successfully 
connected H.323 to H.320  

No action 
required.  

0x0426  
LiveGateway going to 
AWAITING 
ENDSESSION state  

LiveGateway call disconnecting, 
awaiting disconnect with H.323 
system.  

No action 
required.  

0x0427  
LiveGateway going to 
AWAITING HC DISC 
RESP state  

LiveGateway call disconnecting, 
awaiting disconnect with H.320 
system.  

No action 
required.  

0x0428  LiveGateway going to 
REJECT PENDING state  LiveGateway call unsuccessful.  No action 

required.  

0x0429  
LiveGateway going to 
AWAITING MEDIA 
CLOSE 320DISC state  

LiveGateway call disconnecting 
from H.320 system, removing 
H.323 media connections.  

No action 
required.  

0x042A  
LiveManager going to 
AWAITING MEDIA 
CLOSE 323DISC state  

LiveGateway call disconnecting 
from H.323 system, removing 
H.323 media connections.  

No action 
required.  

0x042B  LiveGateway going to 
AWAITING CS DISC

LiveGateway call disconnecting 
f H 320 t i

No action 
required.  



state  H.323 call signaling channel.  

0x042C 
LiveGateway going to 
AWAITING CS DISC 
CONF state  

LiveGateway call disconnecting 
from H.323 system, removing 
H.323 call signaling channel  

No action 
required.  

0x042D  
LiveGateway going to 
AWAITING TICL STOP 
state  

LiveGateway going off line, or 
service is stopping.  

No action 
required.  

0x042E  
Outbound call attempt 
rejected - no LiveGateway 
resources  

LiveGateway unavailable to 
complete call from H.323 
system.  

No action 
required.  

0x042F  LiveGateway: Inbound call 
successful  

H.320 system completed call to 
H.323 system.  

No action 
required.  

 

Warning Messages 
The following table shows Category 3 (warning) messages that appear in the event log and the recommended 
action for each message.  

Event 
Code Description Possible Cause Possible Solution 

0x0540  Registration with 
gatekeeper failed.  

LiveGateway unable 
to register to 
gatekeeper.  

Verify gatekeeper address in 
LiveGateway configuration. 
Verify that gatekeeper is 
running.  

0x0541  Unregistration with 
gatekeeper failed  

LiveGateway unable 
to unregister with 
gatekeeper  

Verify that gatekeeper is 
running.  

0x8001  
PCI Manager 
Received Status 
Indication:  

LiveGateway 
software detects 
possible system 
trouble.  

Use this information when 
reporting issues to 
PictureTel.  

0x8041  
HC Received an 
Unknown 
Message:  

LiveGateway 
software detects 
possible system 
trouble.  

Use this information when 
reporting issues to 
PictureTel.  



0x8060  
PCI Manager 
Received Status 
Code:  

LiveGateway 
software detects 
possible system 
trouble.  

Use this information when 
reporting issues to 
PictureTel.  

0x8062  
HC Control 
Received Status 
Code:  

LiveGateway 
software detects 
possible system 
trouble.  

Use this information when 
reporting issues to 
PictureTel.  

0x8063  
HC Media 
Received Status 
Code:  

LiveGateway 
software detects 
possible system 
trouble.  

Use this information when 
reporting issues to 
PictureTel.  

0x8064  HC has detected a 
Bad Channel Rate:  

LiveGateway 
software detects 
possible system 
trouble.  

Use this information when 
reporting issues to 
PictureTel.  

 

Minor Alarm Messages 
The following table shows Category 4 (minor alarm) messages that appear in the event log and the 
recommended action for each message.  

Event 
Code Description Probable Cause Possible Solution 

0x0060  Failed to delete old 
event log file: filename  

The file may be read-
only.  

Make sure you have 
delete privileges to 
the file.  

0x8080  PCI Manager Ran out of 
Extra Blocks:  

H.323 system's Data 
Sharing channel 
overflowing 
LiveGateway.  

Report to 
PictureTel.  

0x80B1  
H.323 LAN System 
Video Rate Overflowing 
LiveGateway  

H.323 system's Video 
Channel overflowing 
LiveGateway.  

Report to 
PictureTel.  

 



Major Alarm Messages 
The following table shows Category 5 (major alarm) messages that appear in the event log and the 
recommended action for each message.  

Event 
Code 

Description 
Probable 

Cause 
Possible 
Solution 

0x0080  System memory pool has 
reached a critical low:  

The server does not 
have enough 
memory to run 
LiveGateway.  

Increase the amount of 
memory in the server.  

0x0082  
LiveGateway failed report 
status to Service Control 
Manager  

The LiveGateway 
failed to report the 
running status to 
the Service Control 
Manager.  

Stop the LiveGateway 
service and restart it.  

0x0083  LiveGateway system failed 
to open service due to error.  

LiveGateway 
failed to open a 
service.  

Stop the LiveGateway 
service, stop 
H320drvr.sys, and 
restart the 
LiveGateway service.  

0x0280  
SDC configuration file 
change failed (not enough 
memory).  

The memory pool 
is low.  

Increase the amount of 
memory or shut down 
other services or 
application that are not 
necessary.  

0x0281  SDC Failed to post message  SDC could not 
send a message.  

Stop LiveGateway 
service and restart it.  

0x0282  SDC could not allocate 
memory.  

The memory pool 
is low.  

Increase the amount of 
memory.  

0x0283  

Reset failed for 
LiveGateway card number, 
POST result: board number, 
POST result  

LiveGateway could 
not reset the board 
because of the 
specified POST 
result.  

Report error to 
PictureTel.  

0x0284  Reset timeout for 
Li G t d b

LiveGateway 
b d did t t

Report error to 
PictureTel.  



number  within the time 
limit.  

0x0285  SDC could not start a timer.  Software bug.  Report error to 
PictureTel.  

0x0286  Download to LiveGateway 
timed out.  

Files did not 
download from the 
server to the 
LiveGateway 
board within the 
allotted time.  

Report error to 
PictureTel.  

0x0287  
Download to LiveGateway 
failed for card number: 
number  

Files could not 
download from the 
server to the 
LiveGateway 
board.  

Report error to 
PictureTel.  

0x0288  LiveGateway failed to start 
running.  

LiveGateway could 
not start because 
the LiveGateway 
files are corrupted.  

Report error to 
PictureTel.  

0x0289  Could not send message to 
LiveGateway card: number  

LiveGateway 
cannot receive a 
message because of 
possible software 
or hardware errors 
in the LiveGateway 
board.  

Report error to 
PictureTel.  

0x028A  Could not open download 
file: filename  

LiveGateway could 
not open the 
downloaded file 
because the 
specified file is 
missing.  

Reinstall the 
LiveGateway 
software.  

0x028B  Power On Self Test failed. 
Error number= 0x.  or  

Power On Self Test failed. 
LiveGateway card not found 
at specified address. Please 
verify DIP switch settings 
on installed hardware. 

Report the POST 
error code to the 
event log.   
   

I/O Address 
improperly 
configured. 

Report hardware 
failure to PictureTel.   
   
   

Verify DIP Switch 
settings. Refer to 
Appendix B. 



0x0384  LiveGateway Driver failed 
to create registry name:  

Not enough 
privileges.  

Log in as the system 
administrator.  

0x0385  
LiveGateway Driver failed 
to set value for registry 
name:  

Not enough 
privileges.  

Log in as the system 
administrator.  

0x0386  
LiveGateway Driver failed 
to create and start the device 
driver:  

Not enough 
privileges.  

Log in as the system 
administrator.  

0x0387  LiveGateway Driver failed 
to send data to card:  

LiveGateway 
driver failed to 
send the data 
packet to the 
hardware.  

Replace the 
LiveGateway card.  

0x0388  LiveGateway Driver failed 
to read data from card:  

LiveGateway 
driver failed to 
read the data 
packet sent from 
the hardware.  

Replace the 
LiveGateway card.  

0x0389  LiveGateway Driver failed 
to read register from card:  I/O port conflict.  Choose a different I/O 

port.  

0x038A  
LiveGateway Driver failed 
to create file handle for 
card:  

H320drvr.sys not 
installed properly.  

Reinstall the 
LiveGateway 
software.  

0x0480  Failure creating paths 
through the H.320 Mux  Software Error  Contact PictureTel.  

0x0481  
Failed to query the 
IMuxNotify interface from 
Channel Manager  

Software Error  Contact PictureTel.  

0x0482  H.323 Mux Initialization 
Failure  Software Error  Contact PictureTel.  

0x0483  Failed to initialize CP 
properly  Software Error  Contact PictureTel.  

0x0484  H.323 Mux reports an error  Software Error  Contact PictureTel.  

0x0485  U t d T t Software Error  Contact PictureTel.  



Event!  

0x0486  Invalid Event Received In 
Service Queue  Software Error  Contact PictureTel.  

0x0487  Invalid Channel Manager 
Event Received  Software Error  Contact PictureTel.  

0x0488  Not Enough Memory!  Software Error  Contact PictureTel.  

0x0489  
ERROR - new state change 
not handled by state 
changer  

Software Error  Contact PictureTel.  

0x048A  Invalid Timer event from 
queue  Software Error  Contact PictureTel.  

0x048B Failure creating audio paths 
in the H.320 mux  Software Error  Contact PictureTel.  

0x048C  Memory allocation failure 
for LiveGateway  Software Error  Contact PictureTel.  

0x048D  LiveGateway failed to start 
TICL  Software Error  Contact PictureTel.  

0x048E Memory allocation failure 
for LiveGateway  Software Error  Contact PictureTel.  

0x048F  Graph Builder creation 
failure  Software Error  Contact PictureTel.  

0x0490  Failed to create H.323 Mux  Software Error  Contact PictureTel.  

0x0491  Failed to get H.323 Mux 
IMUX interface  Software Error  Contact PictureTel.  

0x0492  Failed to create H.320 Mux  Software Error  Contact PictureTel.  

0x0493  Failed to get H.320 Mux 
IID_I320MUX interface  Software Error  Contact PictureTel.  

0x0494  Failed to get IMediaControl 
interface  Software Error  Contact PictureTel.  



0x0495  Failed to get CP's user 
interface  Software Error  Contact PictureTel.  

0x0496  Failed to get H245's 
IbufferNotify interface  Software Error  Contact PictureTel.  

0x0497  SDC Creation Failure  Software Error  Contact PictureTel.  

0x0498  Viga Driver creation failure  Software Error  Contact PictureTel.  

0x0499  Transport creation failure  Software Error  Contact PictureTel.  

0x049A  TICL creation failure  Software Error  Contact PictureTel.  

0x049B  Timer creation failure  Software Error  Contact PictureTel.  

0x049C  Transport init failure  Software Error  Contact PictureTel.  

0x049D  LiveGateway failed to start 
TICL  Software Error  Contact PictureTel.  

0x049E  LiveGateway going to 
FAILURE state  Software Error  Contact PictureTel.  

0x049F Failed to create channel 
manager  Software Error  Contact PictureTel.  

0x0580  Transport Close returned 
value  Software Error  Contact PictureTel.  

0x0581  Transport ReleaseChannel 
returned value  Software Error  Contact PictureTel.  

0x0582  Transport Open returned 
value  Software Error  Contact PictureTel.  

0x0583  Transport GetChannel 
returned value  Software Error  Contact PictureTel.  

0x0584  
Transport 
TranslateAddressString 
returned value  

Software Error  Contact PictureTel.  

0x0585  T t T l t Add Software Error  Contact PictureTel.  



returned value  

0x0586  Transport Connect returned 
value  Software Error  Contact PictureTel.  

0x0587  Transport Send returned 
value  Software Error  Contact PictureTel.  

0x0588  Transport GetInfo returned 
value  Software Error  Contact PictureTel.  

0x0589  Transport Receive returned 
value  Software Error  Contact PictureTel.  

0x058A  Transport H.225ToTransport 
returned value  Software Error  Contact PictureTel.  

0x058B  Out of memory  Software Error  Contact PictureTel.  

0x058C  Unable to encode RAS 
message  Software Error  Contact PictureTel.  

0x058D  Could not allocate timer 
resource  Software Error  Contact PictureTel.  

0x058E  Invalid timer type  Software Error  Contact PictureTel.  

0x058F  Attempted to start more 
sessions than max  Software Error  Contact PictureTel.  

0x0590  Attempted to access an 
invalid session ID  Software Error  Contact PictureTel.  

0x0591  Could not obtain a call 
reference value  Software Error  Contact PictureTel.  

0x0592  No alias or ID provided for 
gatekeeper operation  Software Error  Contact PictureTel.  

0x0593  
Cannot use forwarding alias 
or ID for non-gatekeeper 
operation  

Software Error  Contact PictureTel.  

0x0594  C ld t bt i t t Software Error  Contact PictureTel.  



header  

0x0595  Could not obtain a RAS 
sequence number  Software Error  Contact PictureTel.  

0x0596  Attempted to access TICL in 
an invalid state  Software Error  Contact PictureTel.  

0x0597  Gatekeeper discovery is 
unsupported at this time  Software Error  Contact PictureTel.  

0x0598  Attempt to access endpoint 
before it has been started   Software Error  Contact PictureTel.  

0x0599  Attempt to close endpoint 
with active calls  Software Error  Contact PictureTel.  

0x059A  Unable to assign a channel 
ID  Software Error  Contact PictureTel.  

0x059B  Unable to encode Q.931 
UUIE  Software Error  Contact PictureTel.  

0x059C  Encountered unexpected 
null pointer  Software Error  Contact PictureTel.  

0x059D  Invalid parameter  Software Error  Contact PictureTel.  

0x059E  Could not allocate timer  Software Error  Contact PictureTel.  

0x059F No transport buffers 
available  Software Error  Contact PictureTel.  

0x05A0  Unable to assign a channel 
ID  Software Error  Contact PictureTel.  

0x05A1  Unable to convert transport 
address  Software Error  Contact PictureTel.  

0x05A2  Unable to convert address 
string  Software Error  Contact PictureTel.  

0x05A3  New Endpoint started  Software Error  Contact PictureTel.  



0x05A4  Endpoint value deleted  Software Error  Contact PictureTel.  

0x05A5  Attempt to create timer 
failed  Software Error  Contact PictureTel.  

0x05A6  Attempt to access 
nonexistent timer  Software Error  Contact PictureTel.  

0x05A7  Attempt to convert address 
string failed  Software Error  Contact PictureTel.  

0x05A8  Attempt to convert transport 
address failed  Software Error  Contact PictureTel.  

0x05A9  ASN.1 encoder/decoder 
initialization failure  Software Error  Contact PictureTel.  

0x05AA  Attempt to access TICL 
before opening it  Software Error  Contact PictureTel.  

0x05AB  Attempt to Close TICL with 
endpoints started  Software Error  Contact PictureTel.  

0x05AC  Attempt to start more 
endpoints than maximum  Software Error  Contact PictureTel.  

0x05AD Attempt to access an invalid 
endpoint  Software Error  Contact PictureTel.  

0x8040  GPP Cannot allocate data 
buffer:  Software Error  Contact PictureTel.  

0x8042  GPP Cannot Send Mail 
message:  Software Error  Contact PictureTel.  

0x08A0  GPP Cannot communicate 
with the BRI module:  

Possible Hardware 
Failure  

Run Customer 
Diagnostics/contact 
PictureTel.  

0x80A1  
GPP Cannot communicate 
with the Audio DSP 
processor:  

Possible Hardware 
Failure  

Run Customer 
Diagnostics/contact 
PictureTel.  

0x80A2  PCI Download Failed:  Possible Hardware 
Failure  

Run Customer 
Di ti / t t



PictureTel.  

0x80A3  Audio DSP Download 
Failed:  

Possible Hardware 
Failure  

Run Customer 
Diagnostics/contact 
PictureTel.  

0x80A4  BRI Module Download 
Failed:  

Possible Hardware 
Failure  

Run Customer 
Diagnostics/contact 
PictureTel.  

 

Fatal Error Messages 
The following table shows Category 6 (fatal error) messages that appear in the event log and the recommended 
action for each message.  

Event 
Code 

Description 
Probable 

Cause 
Possible 
Solution 

0x00A0  LiveGateway terminated 
abnormally.  

LiveGateway has 
terminated as a 
result of the 
preceding error.  

Check the log for and 
correct the preceding 
error.  

0x02A1  Not enough memory to 
configure the system  

The server does not 
have enough 
memory to configure 
the system.  

Increase the amount of 
memory in the server.  

0x02A0  SDC initialization error 
(queue create)  Software bug.  Report error to 

PictureTel.  

0x02A1  Not enough memory to 
configure system  Software bug.  Report error to 

PictureTel.  

0x02A2  SDC thread error (queue 
pend)  Software bug.  Report error to 

PictureTel.  

0x02A3  SDC reached an invalid 
state.  Software bug.  Report error to 

PictureTel.  

0x02A4  SDC could not create a 
timer  Software bug.  Report error to 

PictureTel.  



0x02A5  SDC had a software 
error.  Software bug.  Report error to 

PictureTel.  

0x02A6  
LiveGateway 
configuration file is 
missing.  

LiveGateway cannot 
find the 
configuration file.  

Reinstall the 
LiveGateway software.  

0x03A4  

LiveGateway Driver 
hardware option conflict 
(I/O, IRQ), cardID: board 
number  

LiveGateway board 
has a hardware 
conflict for its   
I/O or IRQ settings.  

Find settings that do 
not conflict with other 
settings and change the 
LiveGateway board 
settings.  

 

ISDN Cause Codes 
Whenever the ISDN network disconnects (or rejects) a call, it generates a Q.931 Cause Code. This code 
message is placed into the LiveGateway Event Log so that the message will be printed out and available to the 
administrator for help in troubleshooting installation/configuration issues and diagnosing ISDN line problems.  

The following table identifies the ISDN Cause Codes that are placed into the LiveGateway Event Log 

ISDN 
Code 

Number 
Name Description 

1  Unallocated 
(unassigned) number  

This cause indicates that the called party 
cannot be reached because, although the called 
party number is in a valid format, it is not 
currently allocated (assigned).  

2  
No route to specified 
transit network 
(national use)  

This cause indicates that the equipment 
sending this cause has received a request to 
route the call through a particular transit 
network which it does not recognize. The 
equipment sending this cause does not 
recognize the transit network either because 
the transit network does not exist or because 
that particular transit network, while it does 
exist, does not serve the equipment which is 
sending this cause.  

3  No route to destination  
This cause indicates that the called party 
cannot be reached because the network 
th h hi h th ll h b t d d



not serve the destination desired. This cause is 
supported on a network dependent basis.  

4  Send special 
information tone  

This cause indicates that the called party 
cannot be reached for reasons that are of a long 
term nature and that the special information 
tone should be returned to the calling party.  

5  Misdialled trunk prefix 
(national use)  

This cause indicates the erroneous inclusion of 
a trunk prefix in the called party number.  

6  Channel unacceptable  
This cause indicates that the channel most 
recently identified is not acceptable to the 
sending entity for use in this call.  

7  
Call awarded, being 
delivered in an 
established channel  

This cause indicates that the user has been 
awarded the incoming call, and that the 
incoming call is being connected to a channel 
already established to that user for similar calls 
(e.g. packet-mode x.25 virtual calls).  

8  Preemption  This cause indicates the call is being 
preempted.  

9  Preemption circuit 
reserved for reuse  

This cause indicates that the call is being 
preempted and the circuit is reserved for reuse 
by the preempting exchange.  

16  Normal call clearing  

This cause indicates that the call is being 
cleared because one of the users involved in 
the call has requested that the call be cleared. 
Under normal situations, the source of this 
cause is not the network.  

17  User busy  

This cause is used to indicate that the called 
party is unable to accept another call because 
the user busy condition has been encountered. 
This cause value may be generated by the 
called user or by the network. In the case of 
user determined user busy it is noted that the 
user equipment is compatible with the call.  

18  No user responding  

This cause is used when a called party does not 
respond to a call establishment message with 
either an alerting or connect indication within 
the prescribed period of time allocated.  



19  No answer from user 
(user alerted)  

This cause is used when the called party has 
been alerted but does not respond with a 
connect indication within a prescribed period 
of time. Note: This cause is not necessarily 
generated by Q.931 procedures but may be 
generated by internal network timers.  

20  Subscriber absent  

This cause value is used when a mobile station 
has logged off, radio contact is not obtained 
with a mobile station or if a personal 
telecommunication user is temporarily not 
addressable at any user-network interface.  

21  Call rejected  

This cause indicates that the equipment 
sending this cause does not wish to accept this 
call, although it could have accepted the call 
because the equipment sending this cause is 
neither busy nor incompatible. This cause may 
also be generated by the network, indicating 
that the call was cleared due to a 
supplementary service constraint. The 
diagnostic field may contain additional 
information about the supplementary service 
and reason for rejection.  

22  Number changed  

This cause is returned to a calling party when 
the called party number indicated by the 
calling party is no longer assigned, The new 
called party number may optionally be 
included in the diagnostic field. If a network 
does not support this cause, cause no: 1, 
unallocated (unassigned) number shall be 
used.  

26  Non-selected user 
clearing  

This cause indicates that the user has not been 
awarded the incoming call.  

27  Destination out of 
order  

This cause indicates that the destination 
indicated by the user cannot be reached 
because the interface to the destination is not 
functioning correctly. The term "not 
functioning correctly" indicates that a signal 
message was unable to be delivered to the 
remote party; e.g. a physical layer or data link 
layer failure at the remote party, or user 
equipment off-line.  
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(address incomplete)  cannot be reached because the called party 
number is not in a valid format or is not 
complete.  

29  Facilities rejected  
This cause is returned when a supplementary 
service requested by the user cannot be provide 
by the network.  

30  Response to STATUS 
INQUIRY  

This cause is included in the STATUS 
message when the reason for generating the 
STATUS message was the prior receipt of a 
STATUS INQUIRY.  

31  Normal, unspecified  
This cause is used to report a normal event 
only when no other cause in the normal class 
applies.  

34  No circuit/channel 
available  

This cause indicates that there is no 
appropriate circuit/channel presently available 
to handle the call.  

35  Call Queued   

38  Network out of order  

This cause indicates that the network is not 
functioning correctly and that the condition is 
likely to last a relatively long period of time 
e.g. immediately re-attempting the call is not 
likely to be successful.  

39  
Permanent frame mode 
connection out-of-
service  

This cause is included in a STATUS message 
to indicate that a permanently established 
frame mode connection is out-of-service (e.g. 
due to equipment or section failure) [see 
Annex A/Q.933]  

40  Permanent frame mode 
connection operational  

This cause is included in a STATUS message 
to indicate that a permanently established 
frame mode connection is operational and 
capable of carrying user information. [see 
Annex A/Q.933]  

41  Temporary failure  

This cause indicates that the network is not 
functioning correctly and that the condition is 
no likely to last a long period of time; e.g. the 
user may wish to try another call attempt 
almost immediately.  



42  Switching equipment 
congestion  

This cause indicates that the switching 
equipment generating this cause is 
experiencing a period of high traffic.  

43  Access information 
discarded  

This cause indicates that the network could not 
deliver access information to the remote user 
as requested, i.e. user-to-user information, low 
layer compatibility, high layer compatibility or 
sub-address as indicated in the diagnostic. It is 
noted that the particular type of access 
information discarded is optionally included in 
the diagnostic.  

44  
Requested 
circuit/channel not 
available  

This cause is returned when the circuit or 
channel indicated by the requesting entity 
cannot be provided by the other side of the 
interface.  

46  Precedence call 
blocked  

This cause indicates that there are no 
preemptable circuits or that the called user is 
busy with a call of equal or higher preemptable 
level.  

47  Resource unavailable, 
unspecified  

This cause is used to report a resource 
unavailable event only when no other cause in 
the resource unavailable class applies.  

49  Quality of Service not 
available  

This cause is used to report that the requested 
Quality of Service, as defined in 
Recommendation X.213, cannot be provided 
(e.g. throughput of transit delay cannot be 
supported).  

50  Requested facility not 
subscribed  

This cause indicates that the user has requested 
a supplementary service which is implemented 
by the equipment which generated this cause, 
but the user us not authorized to use.  

52  Outgoing calls barred   

53  Outgoing calls barred 
within CUG  

This cause indicates that although the calling 
party is a member of the CUG for the outgoing 
CUG call, outgoing calls are not allowed for 
this member of the CUG.  

54  Incoming calls barred   



55  Incoming calls barred 
within CUG  

This cause indicates that although the calling 
party is a member of the CUG for the 
incoming CUG call, incoming calls are not 
allowed for this member of the CUG.  

57  Bearer capability not 
authorized  

This cause indicates that the user has requested 
a bearer capability which is implemented by 
the equipment which generated this cause but 
the user is not authorized to use.  

58  Bearer capability not 
presently available  

This cause indicates that the user has requested 
a bearer capability which is implemented by 
the equipment which generated this cause but 
which is not available at this time.  

62  
Inconsistency in 
outgoing information 
element.  

This cause indicates an inconsistency in the 
designated outgoing access information and 
subscriber class  

63  Service or option not 
available, unspecified  

This cause is used to report a service or option 
not available event only when no other cause 
in the service or option not available class 
applies.  

65  Bearer capability not 
implemented  

This cause indicates that the equipment 
sending this cause does not support the bearer 
capability requested.  

66  Channel type not 
implemented  

This cause indicates that the equipment 
sending this cause does not support the channel 
type requested  

69  Requested facility not 
implemented  

This cause indicates that the equipment 
sending this cause does not support the 
requested supplementary services.  

70  

Only restricted digital 
information bearer 
capability is available 
(national use)  

This cause indicates that the calling party has 
requested an unrestricted bearer service but the 
equipment sending this cause only supports the 
restricted version of the requested bearer 
capability.  

79  
Service or option not 
implemented, 
unspecified  

This cause is used to report a service or option 
not implemented event only when no other 
cause in the service or option not implemented 
class applies.  



81  Invalid call reference 
value  

This cause indicates that the equipment 
sending this cause has received a message with 
a call reference which is not currently in use on 
the user-network interface.  

82  Identified channel does 
not exist  

This cause indicates that the equipment 
sending this cause has received a request to use 
a channel not activated on the interface for a 
call. For example, if a user has subscribed to 
those channels on a primary rate interface 
numbered from 1 to 12 and the user equipment 
or the network attempts to use channels 13 
through 23, this cause is generated.  

83  
A suspended call exists, 
but this call identify 
does not  

This cause indicates that a call resume has 
been attempted with a call identity which 
differs from that in use for any presently 
suspended call(s)  

84  Call identity in use  

This cause indicates that the network has 
received a call suspended request containing a 
call identity (including the null call identity) 
which is already in use for a suspended call 
within the domain of interfaces over which the 
call might be resumed.  

85  No call suspended  

This cause indicates that the network has 
received a call resume request containing a 
Call identity information element which 
presently does not indicate any suspended call 
within the domain of interfaces over which 
calls may be resumed.  

86  
Call having the 
requested call identity 
has been cleared  

This cause indicates that the network has 
received a call resume request containing a 
Call identity information element indicating a 
suspended call that has in the meantime been 
cleared while suspended (either by network 
time-out or by the remote user).  

87  User not a member of 
CUG  

This cause indicates that the called user for the 
incoming CUG call is not a member of the 
specified CUG or that the calling user is an 
ordinary subscriber calling a CUG subscriber.  

88  Incompatible 
destination  

This cause indicates that the equipment 
sending this cause has received a request to 
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compatibility, high layer compatibility or other 
compatibility attributes (e.g. data rate) which 
cannot be accommodated.  

90  Non-existent CUG  This cause indicates that the specified CUG 
does not exist.  

91  Invalid transit network 
selection (national use)  

This cause indicates that a transit network 
identification was received which is of an 
incorrect format as defined in Annex C/Q.931  

95  Invalid message, 
unspecified  

This cause is used to report an invalid message 
event only when no other cause in the invalid 
message class applies.  

96  Mandatory information 
element is missing  

This cause indicates that the equipment 
sending this cause has received a message 
which is missing an information element 
which must be present in the message before 
that message can be processed.  

97  
Message type non-
existent or not 
implemented  

This cause indicates that the equipment 
sending this cause has received a message with 
a message type it does not recognize either 
because this is a message not defined of 
defined but not implemented by the equipment 
sending this cause.  

98  

Message not 
compatible with call 
state or message type 
non-existent or not 
implemented.  

This cause indicates that the equipment 
sending this cause has received a message such 
that the procedures do not indicate that this is a 
permissible message to receive while in the 
call state, or a STATUS message was received 
indicating an incompatible call state.  

99  

Information 
element/parameter non-
existent or not 
implemented  

This cause indicates that the equipment 
sending this cause has received a message 
which includes information 
element(s)/parameter(s) not recognized 
because the information element(s)/parameter 
name(s) are not defined or are defined but not 
implemented by the equipment sending the 
cause. This cause indicates that the information 
element(s)/parameter(s) were discarded. 
However, the information element is not 
required to be present in the message in order 
for the equipment sending the cause to process 
the message.  



100  Invalid information 
element contents  

This cause indicates that the equipment 
sending this cause has received and 
information element which it has implemented; 
however, one or more fields in the I.E. are 
coded in such a way which has not been 
implemented by the equipment sending this 
cause.  

101  
Message not 
compatible with call 
state  

This cause indicates that a message has been 
received which is incompatible with the call 
state.  

102  Recovery on timer 
expiry  

This cause indicates that a procedure has been 
initiated by the expiry of a timer in association 
with error handling procedures.  

103  

Parameter non-existent 
or not implemented, 
passed on (national 
use)  

This cause indicates that the equipment 
sending this cause has received a message 
which includes parameters not recognized 
because the parameters are not defined or are 
defined but not implemented by the equipment 
sending this cause. The cause indicates that the 
parameter(s) were ignored. In addition, if the 
equipment sending this cause is an 
intermediate point, then this cause indicates 
that the parameter(s) were passed unchanged.  

110  
Message with 
unrecognized parameter 
discarded  

This cause indicates that the equipment 
sending this cause has discarded a received 
message which includes a parameter that is not 
recognized.  

111  Protocol error, 
unspecified  

This cause is used to report a protocol error 
event only when no other cause in the protocol 
error class applies.  

127  Interworking, 
unspecified  

This cause indicates that an interworking call 
(usually a call to SW56 service) has ended.  

 



Using LiveManager to Troubleshoot LiveGateway 
 

Overview 
You can use the LiveGateway SNMP Manager feature of LiveManager to access the LiveGateway boards 
installed in a LiveGateway server. The LiveGateway SNMP Manager feature lets you access, control and 
monitor the LiveGateway boards installed in a LiveGateway server. From the LiveGateway SNMP Manager, 
you can:  

• View LiveGateway Statistics 
• Perform Diagnostic Tests 
• Perform a Loopback Test 
• Perform a Self test 
• View board settings and versions 
• View LiveGateway POST results 
• Resolve LiveGateway Problems 

 

Statistics 
The statistics recorded by LiveGateway can be used to help analyze LiveGateway’s system performance. This 
information is useful for testing LiveGateway and reporting problems to your PictureTel field service provider. 

Viewing Statistics 

The statistics displayed in LiveGateway’s Statistics window provides information that can be used to monitor 
the system performance of the LiveGateway server.  

To view the statistics: 

1. Open the LiveGateway server from the LiveGateway SNMP Manager window. 

2. Select the Gateway Boards tab of the LiveGateway Server window. 

3. Perform one of the following actions: 

• Click on a board in the list to highlight the board, and select Operations-
> Show Statistics… from the LiveGateway Server window’s menu bar  

• Right-click your mouse when it is positioned over the board’s entry line 
and select "Show Statistics…" from the popup menu 



4. The Statistics for the selected LiveGateway Board are displayed in the Statistics 
window. The information in this window is read-only. 

 

5. 
To close the Statistics window, click the [X] in the upper right-hand corner. 

 

Diagnostic Tests 
Two types of diagnostic tests can be performed on LiveGateway --  a loopback test and a Power On Self Test 
(POST). Use these tests to diagnose LiveGateway problems and determine where they reside. You can perform 
and self tests to diagnose LiveGateway problems and determine where they reside.  

  

Loopback Test 

The Loopback test helps you to diagnose problems in the LiveGateway board. You need to perform this test 
with a LiveLAN client.  

Note 
LiveGateway does not function when calling ISDN Loopback numbers. 
Therefore it is not a recommended tool for troubleshooting connectivity 
issues.  

The Loop Back Test simulates an inbound H.320 call to a LiveLAN client. This test loops back video and audio 
at the H.320 subsystem within the LiveGateway board. All LiveLAN to H.320 transcoding paths are exercised. 



To perform a Loopback Test on a LiveGateway Board: 

1. Open the LiveGateway server from the LiveGateway SNMP Manager 
window. 

2. Select the Gateway Boards tab of the LiveGateway Server window. 

3. Perform one of the following actions: 

• Click on a board in the list to highlight the board, and select 
Operations... -> Loop Back… from the LiveGateway Server window’s 
menu bar  

• Right-click your mouse when it is positioned over the board’s entry 
line and select "Loop Back…" from the popup menu 

4. The Loopback dialog box appears. Enter the name of the Diagnostic H.323 
Terminal ID in the text field. 

 

5. Click the Start Loopback button after the Loopback test starts, the   Board 
Status changes to Loopback, and the push button caption changes to "Stop 
Loopback.". 

6. To stop the Loopback test, click the Stop Loopback button. 

NOTE 
If the LiveGateway board is in a download or self-test state, you cannot run 
the loopback test, and the Start Loopback selection on the Operations menu 
selection appears dimmed. 

 

Power On Self Test  

If a Fail status is displayed for a LiveGateway Board, perform a Power-On Self Test (POST) by resetting the 
board. The Fail Status for the board is displayed under the Status category of the LiveGateway Boards tab of the 
LiveGateway Server window. 

To perform a Power On Self-test (POST): 
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window. 

2. Select the Gateway Boards tab of the LiveGateway Server window. 

3. Perform one of the following actions: 

• Click on a board in the list to highlight the board, and select 
Operations-> Self Test from the LiveGateway Server window’s menu 
bar  

• Right-click your mouse when it is positioned over the board’s entry 
line and select "Self Test" from the popup menu 

4. After the test completes successfully, the status of the LiveGateway changes to 
Download and then to On Line under the Status column heading of the 
LiveGateway Boards tab.  
 
If the test is not successful, the Fail status is displayed. POST result 
information is useful when you test LiveGateway and you need to report 
problems to your PictureTel service provider. 

The POST results are listed in LiveGateway POST Results. 

 

Viewing Board Settings and Versions  
Information about the LiveGateway board is important when you encounter problems that you cannot correct 
and need to report them to PictureTel.  

To view board settings and version information: 

1. Open the LiveGateway server from the LiveGateway SNMP Manager 
window. 

2. Select the Gateway Boards tab of the LiveGateway Server window. 

3. The following information is displayed for each board in the Gateway Boards 
tab: 

• Status 
• Interface 
• I/O Address 
• IRQ (Interrupt) 
• Hardware Version Number 

To view software version and Gatekeeper information: 



1. Open the LiveGateway server from the LiveGateway SNMP Manager 
window. 

2. Click the Settings tab. The following information is displayed for each board 
in the Settings tab: 

• LiveGateway Software Version Number 
• Gatekeeper Name or Address 

 

Viewing LiveGateway POST Results  
LiveManager retrieves and displays LiveGateway POST results. The following result indicates a successful 
POST.  

POST Code Description 

0xAA  Success  

The following POST results are failures. The descriptions are useful when you are reporting problems to your 
PictureTel service provider.  

POST Code Description 

0x01  GPP EPROM Test  

0x02  GPP 64K DRAM Test  

0x05  GPP DUART Test  

0x06  GPP CPU Internal Reg Test  

0x07  GPP Local Register Test  

0x08  GPP Timer 1 Test  

0x09  GPP Dynamic Memory Test  

0x0A  GPP Interrupt Test  



0x0B  GPP Shared Memory Resource Test  

0x0C  GPP to Shared Memory Transfer Test  

0x0D  GPP Wild Interrupt Test  

0x10  Audio DSP SRAM Test by GPP  

0x11  VDSP SRAM to GPP DRAM Transfer Test  

0x12  Audio DSP SRAM Test by ADSP  

0x13  Audio DSP to SMR  

0x14  DMA SMR to Audio DSP  

0x15  Audio DSP from GPP Interrupt Test  

0x16  VDSP SRAM to GPP DRAM Transfer Test  

0x17  Audio DSP Program Mem Write Only  

0x18  Enable ADSP to Run  

0x20  PCI SRAM Test by GPP  

0x21  PCI EZ Run Test  

0x22  PCI Interrupt Handshaking to CPUs  

0x23  PCI SRAM Test by PCI  

0x25  PCI SRAM to GPP DRAM Transfer Test  

0x40  BRI SRAM Test by GPP  

0x41  BRI Frame Sync Test  

0x42  BRI Loopback Test  

0x43  BRI Interrupt Handshaking to CPUs  



0x55  Conflict Shared Memory DSPs and GPP  

0x56  Conflict Shared Memory GPP only  

0x57  Read Shared Memory after ISA Write 

 

Resolving LiveGateway Problems 
The following information describes how to identify and resolve the most commonly encountered LiveGateway 
problems by using LiveGateway’s diagnostics and event log (event monitoring and recording) features. 
LiveGateway stores informational messages, tracking messages, warning messages, and error messages in the 
event log. The information in the log helps you monitor LiveGateway traffic. 

You can also resolve LiveGateway problems by using the LiveGateway SNMP Manager from within the 
LiveManager Gatekeeper software-based product. The LiveGateway SNMP Manager feature lets you access, 
control and monitor the LiveGateway boards installed in a LiveGateway server. From the LiveGateway SNMP 
Manager, you can:  

• View LiveGateway statistics 
• Perform diagnostic tests 
• View settings 

Most LiveGateway problems can be located and resolved by performing diagnostic tests and/or analyzing 
statistical and settings-related data monitored and recorded by LiveGateway.  

Most Commonly Encountered Problems 
 The most commonly encountered LiveGateway problems are categorized as follows:  

•  General Installation/Startup Failures 
•  LiveGateways can't be added to the LiveManager SNMP Manager 
•  LiveManager Registration Errors 
•  LiveGateway ISDN Configuration Errors 

 Problem: Can't Start LiveGateway Service 

 Use the following checklist to quickly identify and resolve this problem.  

Probable Causes:  

  

• Software not fully installed. 
• Boards are not configured/enabled. 
• Conflicting IRQ or I/O selection. 



What You Should Check 
and/or Verify:  

  

• Was installation from CD ROM successful? 

• Did you configure and enable any boards via the 
configuration utility? 

• After you started the application, did any error 
messages appear on the screen? 

• Does LiveGateway log have any messages pointing to 
a possible IRQ or I/O conflict? 

Possible Solutions:  

  

• Reinstall software. 

• Run LiveGateway configuration utility to add/enable 
board. 

• Select another IRQ or I/O address (check in Windows 
NT Diagnostics for resource usage). 

Problem: Can't Add LiveGateway to LiveGateway SNMP Manager Console 

 Use the following checklist to quickly identify and resolve this problem.  

Probable Causes:  

  

• Wrong IP address of server. 

• SNMP not running on server and/or client. 

• LiveGateway not configured to run SNMP. 

What You Should 
Check and/or 
Verify:  

  

• Is the SNMP Service installed and running on the server? 
• Is SNMP running on the client? 
• Is SNMP enabled on the LiveGateway? 
• How did you obtain the IP address of the server? 

Possible 
Solutions:  

• Install SNMP Service on NT system and ensure it is running. 
• Enable SNMP for LiveGateway via LiveGateway 

configuration utility. 
• Enter valid IP address for LiveGateway server when adding 

LiveGateways to the LiveManager console (check Network 



installed). 

Problem: LiveGateway Starts, Then Fails 

 Use the following checklist to quickly identify and resolve this problem.  

Probable Causes:  

• POST failure. 
• POST successful, but card not responding. 
• Missing download file. 
• Download timeout/possible hardware failure with ISA access.  

What You Should 
Check and/or 
Verify:  

• Look at LiveGateway log file for error messages. 

Possible 
Solutions:  

  

• POST failure: Get a new card. 
• POST successful, but card not responding: Try another IRQ. 
• Missing download file: Reinstall software. 
• Download timeout/possible hardware failure with ISA access: 

Try Bootup Board diagnostics. If failure detected, get a new 
card. If no failure detected, provide PictureTel with server 
hardware information. 

Problem: LiveGateway Starts, Downloads, But Is Not Online 

 Use the following checklist to quickly identify and resolve this problem.  

Probable Causes:  

  

• LiveManager Application is not active. 
• LiveManager Application rejects registration attempt. 
• LiveManager not entered during LiveGateway 

configuration.  

What You Should 
Check and/or Verify:  

  

• Is LiveManager application running? 
• Has LiveManager been configured to recognize the 

LiveGateway server (LiveManager network topology)? 
• Has the LiveManager been configured by the 

LiveGateway configuration utility (via the Gatekeeper 
button)?  



Possible Solutions:  

• Start LiveManager application. 
• Add LiveGateway server network information to 

LiveManager network topology. 
• Configure LiveManager via the LiveGateway 

configuration utility. 

Problem: LiveGateway Online, But Can't Make Or Receive Calls 

 Use the following checklist to quickly identify and resolve this problem. 

Probable Causes:  

  

• ISDN line inactive. 
• ISDN configuration error. 
• ISDN software error.  

What You Should 
Check and/or Verify:  

  

• Look in the LiveGateway log to see the ISDN status. 
• Collect ISDN installation information, switch type, 

number type, number plan, SPIDs and MSN 
information. 

• Does the ISDN configuration information match the 
line provisioning information? 

• Are you able to verify line in "known good" system?  

Possible Solutions:  

  

• If ISDN link is DOWN, verify wiring. Otherwise, 
contact phone company. 

• Consult manual for default ISDN switch settings.  

Problem: Can Call Out To WAN, Can't Call In 

 Use the following checklist to quickly identify and resolve this problem.  

Probable Causes:  

  

• Improperly configured MSN or SPIDs. 
• Caller is trying the wrong number.  

What You Should Check 
and/or Verify:  

  

• Verify that your MSN or SPID information matches 
what is provided by the phone company. 

• Verify that you can call into the line when plugged 
into a "known good" system.  



Possible Solutions:  

  

• Reconfigure ISDN switch settings (MSNs, SPIDs). 

Problem: Can Call In From WAN, Can't Call Out 

 Use the following checklist to quickly identify and resolve this problem.  

Probable Causes:  

  

• Caller is entering incorrect H.320 dial string. 

• Called system is on a restricted network. 

• Gateway prefix is not being used. 

• SPID, Number type, or Number plan error in ISDN 
configuration.  

What You Should Check 
and/or Verify:  

  

• Verify that the LiveManager and LiveGateway are 
configured to use the same Gateway Prefix.  

• Verify that ISDN configuration information matches 
what is provided by the phone company. 

• Verify that you can dial out on the line when plugged 
into a "known good" system.  

Possible Solutions:  

  

• Try one call at 2x56K channel rate. 
• Reconfigure ISDN switch settings (number plan, 

number type, SPIDs). 
• Activate ISDN logging, send file to PictureTel.  

If the troubleshooting procedures do not help you resolve the problem, access the LiveGateway Technical 
Bulletins from the Support area of the PictureTel web site at www.picturetel.com. The Technical Bulletins can 
be accessed by clicking the Proactive Support link in the Support area of the PictureTel web site.  

The Technical Bulletins are documents created by PictureTel Technical Support to supplement existing 
publications. Each Technical Bulletin describes a problem, the cause of the problem, and the solution. It is 
highly recommended that you visit this site if you encounter a problem. Many times the solution can be found 
quickly and easily.  

If the information in these Technical Bulletins does not help resolve your problem, then please contact 
your PictureTel sales representative. If your sales representative does not provide support, you may 
contact PictureTel directly. 



Contacting Technical Support 
 

Overview 
For assistance of any kind, contact your Distributor for support. If you do not know where you purchased your 
equipment, call PictureTel directly and we will assist or direct you to your appropriate Distributor if applicable. 

When you call for assistance, please have the following information available:  

• The serial number of your software. You can find the serial number on the warranty registration card. 
• The LiveGateway Version number. 
• Information about your system’s configuration and network. 
• Any system error messages or error codes. 
• Symptoms of the problem you are experiencing. 

 

Web Page 
PictureTel’s Web page includes information about the PictureTel Corporation, products, and user groups, as 
well as Customer Support information. The Customer Support section of the Web site allows customers to 
access technical support information and worldwide support locations, download software files such as patches 
and updates, receive email support, and more.  

To access the PictureTel web site, enter the following URL in your web browser: 

http://www.picturetel.com 

 

Ordering Components 
To order replacement components, locate the part number, and contact your PictureTel distributor. If your 
distributor does not provide replacement service, you may contact the PictureTel World Wide Web site 
(www.picturetel.com) to obtain technical support information, or call PictureTel Customer Service at 1-800-
8PICTEL (800-874-2835). 

 

Returning Components 
To return LiveGateway components:  

1. It is important that you RETURN ALL COMPONENTS ACCORDING TO THE DISTRIBUTOR’S 
INSTRUCTIONS. 

2. If returning components directly to PictureTel, you will require a Return Material Authorization (RMA) 
number. Contact Customer Service at 1-800-8PICTEL (800-874-2835) to obtain the RMA. 

http://www.picturetel.com/


3. After receiving the RMA number, wrap the component in an antistatic bag, and pack the component in a 
shipping container, using bubble wrap if necessary. If possible, use the original PictureTel packaging. 

4. If returning the component directly to PictureTel, ship the container to: 

Customer Service Logistics 
PictureTel Corporation 
100 Minuteman Road 
Andover, MA 01810  
U.S.A. 
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